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CHAPTER 1

Introduction
Supported In:

You can add the search feature to any of your online output targets. When users want to find inform-
ation about a specific subject, they enter key words in the Search field. A search engine looks
through every topic in your project to find the term(s) entered by the user. When it finds the terms, it
presents the user with a list of topics to open. The way that search works differs depending on the
output type. There are also special features that you can use to enhance search, such as synonyms,
partial-word search, filters, reports, and excluding topics from search.

This chapter discusses the following:

Search Features and Capabilities 8

Searching the Outputs 18

Optimizing Search 19

Steps for Setting Up Search 20
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Search Features and Capabilities
The search features and capabilities that are available in your published Flare output depend on the
output type. In addition, you can perform search queries using different search methods and syntax
when you publish client- or server-based output:

n Client-based Output With the web-based output types, search operations are supported by a
Flare search database. This database consists of an array of JavaScript and XML files that
are built and published with the Flare output in the Data folder. With WebHelp AIR, search is
built-into the Adobe AIR package. With Microsoft HTML Help, the Microsoft Compiled HTML 
(CHM) Help file format also offers a built-in search engine. With DotNet Help, an array of
XML files is published to the Data folder in the Flare output, or you can publish an SQL Server
database.

n Server-based Output Search features can be enabled/disabled in Flare and search operations
are supported by server-based tools. For example, the server-based WebHelp and HTML5 out-
put types can be enabled in Flare, and then published to an Internet Information Services (IIS)
server. For these outputs, search operations are supported by the Microsoft Indexing Service
or Windows Search.

n Elasticsearch The Elasticsearch method is a powerful search engine you can use in your
server-based online output. It gives your users more accurate and efficient search results,
and includes features such as predictive search, auto-completion, and fuzzy matches. This is
enabled by the use of the MadCap Process Manager, which manages the Elasticsearch ser-
vice and the Flare web service.

n Google Search As an alternative to Elasticsearch or Flare’s built-in MadCap Search, you can
set up a search engine to use Google Search instead. This is a good option if you prefer the
search results returned by Google.

TIP: To determine the type of search that is best for you, we recommend that you
generate different outputs using each method. Then perform several different
searches and see which results you like best.

n Eclipse Help End user search features are supported by the Eclipse Help Viewer and search
operations are provided by a plug-in that you develop using the Eclipse platform (for more
information, see help.eclipse.org). The Flare search engine does not handle Eclipse Help
search operations.
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End User Search Features
The table below summarizes the key search features and capabilities for each output type. With
HTML5 and WebHelp outputs, you can distribute either client- or server-based outputs. This is why
the table below lists them twice—under client- and server-based output.

CLIENT-BASED OUTPUT
SERVER-

BASED OUTPUT

Glossary Search

(Find Matching

Terms)

Index Search (Find

Matching Terms)

Predictive Search

See "Setting Up a

Search Engine" on

page 169.

Search Favorites

(Save Queries to

Favorites List)

Search Query (Aster-

isk (*) Wildcard

Character)

Search Query

(Boolean Operators)

See "Search Meth-

ods and Syntax" on

page 126.
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CLIENT-BASED OUTPUT
SERVER-

BASED OUTPUT

Search Query (Full-

text Search—not

case sensitive)

See "Search Meth-

ods and Syntax" on

page 126.

Search Query

(Enclose Terms in

Quotes)

See "Search Meth-

ods and Syntax" on

page 126.

Search Results (Nar-

row Search Scope

Using Search Filter

Sets)

See "Search Filter

Set Example" on

page 55.

Search Results (Res-

ults Listed in

Ranked Order and

Show Rank Num-

ber)

See "Optimizing

Search" on page

168.
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CLIENT-BASED OUTPUT
SERVER-

BASED OUTPUT

Search Results

(Search Hits High-

lighted in Topics)

See

"Search Highlighting

and Styles" on page

70.

Search Results

(Search Hits Bolded)

1Use CTRL+F in the Glossary pane.

2SQL Server Compact is required.

3Select the operator from the built-in list.

4Search filters are not supported in Elasticsearch.

5Results are listed in order. Rank number is not visible.
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Content Developer Search Options
This table summarizes the key search features and capabilities that are available to you, the con-
tent developer, for each output type. With HTML5 and WebHelp outputs, you can distribute either cli-
ent- or server-based outputs. This is why the table below lists them twice—under client- and server-
based output.

CLIENT-BASED OUTPUT
SERVER-

BASED OUTPUT

Enable

"Enabling Search

in Skins" on page

22

Content Optim-

ization

"Setting the

Search Abstract

Character Limit"

on page 222

Content Optim-

ization

"Setting Search

Result Import-

ance" on page

228

CHAPTER 1  12



CLIENT-BASED OUTPUT
SERVER-

BASED OUTPUT

Content Optim-

ization

"Including Gloss-

ary Terms in

Search Results"

on page 224

Content Optim-

ization

"Setting the Num-

ber of Search Res-

ults Per Page" on

page 232

Google Search

"Setting Up a

Search Engine" on

page 169

Search High-

lighting

"Customizing

Highlighted

Search Terms" on

page 72
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CLIENT-BASED OUTPUT
SERVER-

BASED OUTPUT

Search Per-

formance

"Chunking Large

Search Database

Files" on page 26

Search Optim-

ization

"Enabling Partial-

Word Search" on

page 32

Search Optim-

ization

"Including Stop

Words in Search"

on page 36

Search Per-

formance

"Excluding Index

Entries From

Search" on page

29
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CLIENT-BASED OUTPUT
SERVER-

BASED OUTPUT

Search Per-

formance

"Excluding Non-

words from

Search" on page

31

Search Per-

formance

"Including an SQL

Search Database"

on page 35

Search Per-

formance

"Pre-merging

Search Database

Files" on page 34

Search Per-

formance

"Setting the N-

Gram Size for

Search" on page

30
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CLIENT-BASED OUTPUT
SERVER-

BASED OUTPUT

Search Toolbar

Specifying Web

Toolbar Set-

tings—WebHelp

Outputs

Search Results

"Customizing

Search Filter

Ordering" on page

51
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CLIENT-BASED OUTPUT
SERVER-

BASED OUTPUT

Styles

"Styles for Gen-

erated Pages" on

page 76

1HTML5 skin.

2Search cannot be disabled.

3Standard skin.

4Mobile skin.

5This is supported if you are using Elasticsearch or MadCap Search,but not Google Search.

6This is supported only in HTML5 Side Navigation, Top Navigation, and skinless outputs. It is not supported
in HTML5 Tripane output.

7Stop words are always enabled.

8Index entries are always excluded.

9Non-words are always excluded.

10SQL Server Compact is required.
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Searching the Outputs
Depending on the output type, the user interface for your published output offers different search
features and functionality. See "Searching the Outputs" on page 125.

When compiling your online output, the build process generates a search database with your tar-
get's output files. When an end user searches for information, the search process looks through this
database to retrieve a list of topics containing matching criteria.

Depending on the output type you are searching, end users can perform a variety of simple text and
phrase searches. Some output types also support the use of boolean operators, the asterisk (*) wild-
card character, and other syntax. See "Search Methods and Syntax" on page 126.
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Optimizing Search
You have a variety of options when it comes to improving topic and page ranking for search results.
This includes setting up a search engine for MadCap Search, Google Search, or Elasticsearch. We
have a collected a variety of tips and best practices for optimizing results when using the Flare
engine. You'll also find tips for optimizing content for search engine providers. See "Optimizing
Search" on page 168.

Also, keep in mind that HTML5 Side and Top Navigation outputs are frameless. This has the fol-
lowing benefits when it comes to search:

n Better Search Engine Optimization Side or Top Navigation means better search engine optim-
ization (SEO). This is thanks in part to the absence of iframes. In addition, the output is not
dynamically loaded in div tags, but rather the content is flattened, which makes it easier for
web crawlers to locate.

n Navigation Displays with External Search Results Side or Top Navigation provides a better
experience with external searches and navigation. For example, if you have Tripane output
and click on a Google search result for a specific page, that page opens without the sur-
rounding navigation (e.g., TOC) included in that Help system. But with Side or Top Navigation
output, that same page would display with its intended navigation.
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Steps for Setting Up Search
1. Enable Search in the Skin Open the skin being used to generate the output type and enable

the search feature. See "Enabling Search in Skins" on page 22.

2. Set Up Search Engine For HTML5 targets, you can choose the type of search engine you
want people to use—MadCap Search, Google Search, or Elasticsearch (for Side Navigation,
Top Navigation, or skinless output). There are additional steps that you can follow to set up
each of these engines. For MadCap Search, this includes setting the search result import-
ance, including glossary terms in the results, setting the number of results per page, and set-
ting the abstract character limit. For Google Search, this includes creating a new search
engine, verifying the URL, adding a sitemap, submitting the site for indexing, excluding the
TOC from indexing, customizing the appearance of the results, and reviewing the indexing
status. For Elasticsearch, there are several search results and auto-complete results you can
configure for your search engine. See "Setting Up a Search Engine" on page 169.

3. (Optional) Include or Exclude Topics in Search You can include or exclude a topic when full-
text search is generated. If you disable this feature, the topic will be excluded from the
search, but it will still be included in the generated output. See "Include/Exclude Topics in
Search" on page 24.

4. (Optional) Configure the Search Database In a Flare target, you have a variety of options that
you can enable or disable to define how the search database performs. See "Configuring the
Search Database" on page 25.

5. (Optional) Narrow the Scope of a Search Using a Search Filter Set Your target output can
include a search filter set. A filter set works with the concepts feature. Each set includes fil-
ters that you define to limit the scope of the end user's search query to only the topics that are
associated with the selected filter. See "Adding Search Filter Set Files to Projects" on page 43,
"Creating Search Filters" on page 49, "Customizing Search Filter Ordering" on page 51, "Asso-
ciating a Search Filter Set with a Target" on page 52, and "Search Filter Set Example" on page
55.

6. (Optional) Create Synonyms for Search You can make improvements to your output so that,
in the future, users are able to find the search results they need. One way to enhance your out-
put is to create synonyms for search phrases. This way, even if a user enters a search term
that is not included anywhere in the project, that person will still be able to find the appropriate
information. See "Tasks for Using Synonyms" on page 61 and "Creating Synonyms to Enhance
Search Results" on page 64.

7. (Optional) Customize Search Highlighting When users initiate a search query, the search hits
(i.e., the matching keywords and phrases) may be highlighted when the individual topics are
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opened. This feature is called "search highlighting" and it is supported for simple text search
and phrase search. Note that when searching with wildcard characters, the search feature
will not apply highlighting to search hits. See "Search Highlighting and Styles" on page 70 and
"Customizing Highlighted Search Terms" on page 72.

8. (Optional) Set Up the Server-based Features Server-based outputs give you the ability to
include non-XHTML files in search.

l HTML5 See "HTML5 Server-based Output" on page 80 and "Including Non-XHTML Files in
HTML5 Search" on page 98.

l WebHelp Plus See "WebHelp Plus Server-based Output" on page 102 and "Including Non-
XHTML Files in Search" on page 121.

CHAPTER 1  21



CHAPTER 2

Enabling Search in Skins
The first step in making search accessible in your online documentation is to enable the feature in
the skin that you want to use for your output target. This setting might already be selected by
default in your skin.

HOW TO ENABLE SEARCH IN A SKIN—HTML5 OUTPUT

1. From the Project Organizer, open the HTML5 skin.

2. Select the Styles tab.

3. In the Header section, expand Search Bar.

4. Expand Layout.

5. In the Display field, make sure block is selected.

6. Click to save your work.
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HOW TO ENABLE SEARCH IN A SKIN—HTML HELP, WEBHELP, WEBHELP AIR, WEBHELP
MOBILE, AND WEBHELP PLUS

1. From the Project Organizer, open the Standard or Mobile skin.

2. Select the General tab.

3. In the Features list, click the Search check box.

4. (Optional) If you are creating Microsoft HTML Help, you can include advanced search options.
To enable or disable these options, open the skin. In the Skin Editor, click the HTML Help
Setup tab, then place a check in the Show Advanced

5. Search box.

6. Click to save your work.

IMPORTANT: Unlike other online outputs, DotNet Help packages your content so it is
accessible to end users with the Help Viewer redistributable. As such, the Help Search Win-
dow and Help Index Window are always enabled. These features cannot be disabled using
the controls that are visible in the General tab of the Skin Editor.

NOTE: If you are generating WebHelp Mobile output, please note that search is not sup-
ported in LG WebOS (Palm WebOS).
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CHAPTER 3

Include/Exclude Topics in
Search
Supported In:

You can include or exclude a topic when full-text search is generated. If you disable this feature, the
topic will be excluded from the search, but it will still be included in the generated output.

HOW TO INCLUDE OR EXCLUDE TOPICS IN SEARCH

1. Open the Content Explorer.

2. Locate and click on the topic file.

3. In the local toolbar, click . The Properties dialog for the file opens.

4. Click the Topic Properties tab.

5. Click the check box labeled Include topic when full-text search database is generated.

6. Click OK.

NOTE: In Microsoft HTML Help, all topics are always searchable.
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CHAPTER 4

Configuring the Search
Database
In a Flare target, you have a variety of options that you can enable or disable to define how the
search database performs.

This chapter discusses the following:

Chunking Large Search Database Files 26

Excluding Index Entries From Search 29

Setting the N-Gram Size for Search 30

Excluding Non-words from Search 31

Enabling Partial-Word Search 32

Pre-merging Search Database Files 34

Including an SQL Search Database 35

Including Stop Words in Search 36
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Chunking Large Search Database Files
Supported In:

When Flare builds your output files, it also automatically generates a search index. The search data-
base is split into a series of chunk files with JS file name extensions. These "chunks" are very import-
ant to your project, because they help to improve the performance of the search feature.

SEARCH DATABASE FILES AND MAXIMUM CHUNK SIZE

Important things to know about chunk files include:

n Chunk Files are Automatically Created in Sequential Order The build process automatically
creates a search database and then splits the database information into individual chunks.
Each chunk is represented by a chunk file. The naming convention used for these files is
sequential (e.g., SearchPhrase_Chunk0.js, SearchPhrase_Chunk1.js, SearchPhrase_
Chunk2.js). After running a build, these files are required by the target output and stored in the
target's Output\Data folder.

If you installed Flare in the default location, the path to the Output\Data folder is: C:\Users\
[user name]\Documents\My Projects\[project name]\Output\[user
name]\[target name]\Data
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n There are Three Kinds of Chunk Files Search chunks come in three varieties: SearchPhrase
chunks, SearchStem chunks, and SearchTopic chunks. Each chunk type holds a different kind
of data. By separating search chunks into different files that contain phrases, stems, and top-
ics, Flare's search engine can locate data faster.

n Number of Chunk Files Depends on Project Content and Settings The total number of chunk
files generated by the build process depends entirely on the size of your project and the
search performance settings that you enable. As a general rule, smaller projects have fewer
chunk files than larger projects. Other factors to consider include the maximum chunk size
setting and whether the partial-word search feature is enabled. See "Enabling Partial-Word
Search" on page 32.

n New Chunk Files are Generated With Every Build When you update your content and build new
output files, Flare generates new chunk files to ensure your updated content can be retrieved
when end users perform a search. If you are publishing server-based output, always ensure
that your publishing and upload process for your output includes the updated chunk files.

HOW TO SET THE MAXIMUM CHUNK SIZE FOR SEARCH DATABASE FILES

1. In the Project Organizer, open the desired target.

2. In the Target Editor, click the Search tab.

3. Expand the Advanced Search Options section.

4. Place a check mark in the Chunk Large Search Database Files box. Then select a value in the
Maximum Chunk Size box.
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NOTE: The smallest maximum file size for a chunk file is 10,000 bytes. The largest
maximum file size is 100,000 bytes. The default setting for the maximum chunk file
size is set to 30,000 bytes.

5. Click to save your work.
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Excluding Index Entries From Search
Supported In:

If you insert index markers in your project, those markers by default are included in searches that
users perform in your output. If you want to exclude index entries from searches, you can do so.

HOW TO EXCLUDE INDEX ENTRIES FROM SEARCH

1. Open the target.

2. Select the Search tab.

3. In the Search Results section, click the drop-down arrow next to Advanced Search Options.

4. Click Exclude index entries from search.

5. Click to save your work.

NOTE: This option is not available for HTML5 targets using Elasticsearch or Google Search.
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Setting the N-Gram Size for Search
Supported In:

N-grams can be applied to the search database to improve its ability to retrieve more accurate
matches for Chinese, Japanese, and Korean languages.

ABOUT N-GRAMS

In the English language, sentences are composed of a sequence of words. Because English words
are separated by spaces, search engines have a reliable pattern for detecting word boundaries
when retrieving search results. In other languages, such as Chinese, Japanese, and Korean, spaces
are not used to separate words. This makes the task of retrieving accurate matches for these lan-
guages more challenging for search engines.

To address this issue efficiently, the search database can be set to use the n-gram model to help it
more accurately predict word patterns. This improves the search feature's ability to retrieve accur-
ate search results for the Chinese, Japanese, and Korean languages.

HOW TO SET THE N-GRAM SIZE

1. In the Project Organizer, open the desired target.

2. In the Target Editor, click the Search tab.

3. Expand the Advanced Search Options section.

4. In the N-gram size box, select a value between 1- 5.

TIP: Applying an n-gram value to a project affects the size of the search database. It
also affects the quantity and accuracy of the search results. In general, lower n-gram
values (e.g., 1-2) result in a smaller database. As a result, end user search queries will
typically retrieve a higher number results with less accurate matches. Similarly, larger
n-gram values (e.g., 4-5) result in a larger database. Therefore, search queries will typ-
ically retrieve a smaller number of results with more accurate matches.

5. Click to save your work.
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Excluding Non-words from Search
Supported In:

Flare has a non-words list that works behind the scenes to omit common non-words from user
searches (for example, angle brackets [ ]). When you set this option and a user enters non-words in
a search query, the system won't look for those non-words.

HOW TO EXCLUDE NON-WORDS FROM SEARCH

1. In the Project Organizer, open the desired target.

2. In the Target Editor, click the Search tab.

3. In the Search Results section, click the drop-down arrow next to Advanced Search Options.

4. Place a check mark in the Exclude non-words from search box. To include non-words in
search, clear the check mark.

5. Click to save your work.

NOTE: This option is not available for HTML5 targets using Elasticsearch or Google Search.
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Enabling Partial-Word Search
Supported In:

For some online outputs, you can provide end users with partial-word search capabilities. This lets
users type part of a word or any string (including numbers), press Enter or click the Search button,
and see search results matching those characters.

HOW TO ENABLE PARTIAL-WORD SEARCH

1. In the Project Organizer, open the target.

2. Select the Search tab.

3. In the Search Results section, place a check mark in the Partial word searching box.

4. In the Minimum word size field, enter the number of characters a user must type before see-
ing results. The minimum value is 3, the maximum value is 100.

NOTE: The higher the minimum word size that you enter, the smaller the search data-
base.

5. Click to save your work.
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EXAMPLE

Let’s say that in the Search field, you enter cond.

Search finds matches in "conditioning" and "second."

This feature is not limited to words only. It works with any string (including numbers) that starts and
ends with a space. For example, let's say that the IP address numbered "192.168.10.1" is included in
one of your topics. To find the topic that includes the match, simply type 10.1 in the search field.

NOTE: Partial-word search is not supported in server-based output.

IMPORTANT: Enabling partial-word search in client-based outputs increases the size of the
search database included with your target output. It also increases the amount of time it
takes to build and publish the output.
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Pre-merging Search Database Files
Supported In:

If you have multiple projects and plan to merge their outputs when building the "master" project, you
can pre-merge the search database files.

HOW TO PRE-MERGE SEARCH DATABASE FILES

1. In the Project Organizer, open the target.

2. Select the Search tab.

3. Expand the Advanced Search Options section.

4. Place a check mark in the Pre-merge search database file box.

5. Click to save your work.
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Including an SQL Search Database
Supported In:

You have the option to include an SQL database to support search with the published output. This
can improve search performance and permit users to use the asterisk (*) wildcard with search. For
example, if you type Mad* in the Search field, Flare will list all topics with words that have "Mad" fol-
lowed by any other letters (e.g., MadCap, Madagascar, madness, Madrid).

HOW TO INCLUDE AN SQL SEARCH DATABASE

1. In the Project Organizer, open the target.

2. Select the Search tab.

3. In the Search Results section, place a check mark in the Include SQL search database box.

4. Click to save your work.
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Including Stop Words in Search
Supported In:

Flare has a hard-coded stop words list that works behind the scenes to filter out common structure-
class words (i.e., function words) from search operations. This means the Flare search engine
excludes words (e.g., "an," "for," "of, and "the") by default. However, if you want the search engine to
search for queries with these words, you can include the stop words list in search.

Below is the list of hard-coded English stop words that the Flare search engine excludes from
search by default. If you want to create a custom stop words list, you can create one on your local
computer using Language Skins as described below.

a

about

after

against

all

also

among

an

and

are

as

at

be

became

because

been

between

but

by

can

come

do

during

each

early

for

found

from

had

has

have

he

her

his

however

in

include

into

is

it

its

late

later

made

many

may

me

med

more

most

near

no

non

not

of

on

only

or

other

over

several

she

some

such

than

that

the

their

then

there

these

they

this

through

to

under

until

use

was

we

were

when

where

which

who

with

you

your
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NOTE: The stop words list applies to English projects only. If you wish to create a custom
stop words list for another language, use the instructions below to create a custom list of
stop words.

NOTE: For best results, it is recommended that you use the default setting (i.e., stop words
are automatically excluded from search). This typically returns the most relevant search
results.

NOTE: "If" and "will" are also recognized as stop words when using Elasticsearch as your
search engine.

HOW TO INCLUDE THE STOP WORDS LIST IN SEARCH

By default, the words on the stop words list are excluded from search. To include them, complete
the following steps.

1. In the Project Organizer, open the desired target.

2. In the Target Editor, click the Search tab.

3. In the Search Results section, place a check mark in the Include stop-words in search box.

4. Click to save your work.
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Creating a Custom Stop Words List
In Flare, the stop words list is hard-coded. However, you can create your own stop words list on your
local computer using language skins.

HOW TO CREATE A LOCAL COPY OF THE STOP WORDS LIST

These instructions show you how to create a stop words list for an English language skin. You can
also use these instructions to create a custom stop word list for other languages.

1. Open a Flare project.

2. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select the Project ribbon. In the Content section select New > Advanced > Add
Language Skin.

n Right-Click In the Project Organizer, right-click on the Advanced folder and from the con-
text menu select Add Language Skin.

The Add File dialog opens.

3. In the File Type field at the top, make sure Language Skin is selected.

4. (Optional) If you want to place the file into a subfolder previously created in the Project Organ-
izer, in the Folder field click and select the subfolder. Otherwise, keep the default loc-
ation.

5. From the Language drop-down, select the language you want to use for the language skin.

6. In the File Name field, type a new name for the language skin.

7. (Optional) If you want to apply condition tags to the file, expand the Attributes section at the
bottom of the dialog. Next to the Condition Tags field, click and select the conditions you
want to apply. Click OK.

8. (Optional) If you want to apply file tags, expand the Attributes section at the bottom of the dia-
log. Next to the File Tags field, click and select the file tags you want to apply. Click OK.
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9. Click Add. The language skin is added to the Advanced folder in the Project Organizer. The
Language Skin Editor opens to the right, with the new language skin shown. Depending on the
language you selected when creating the language skin, the skin may include default trans-
lations for some UI text strings.

This creates a copy of the project language skin file and places it in your Project's Advanced
folder (e.g., C:\Users\[username]\Documents\My Projects\[project name]\Pro-
ject\Advanced). The language skin file name uses the *.fllng file name extension (e.g., af.fllng,
en.fllng, es.fllng).

10. Close the Language Skin Editor.
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HOW TO MODIFY THE STOP WORDS LIST

1. Open the Project Organizer.

2. Double-click the Advanced folder.

3. Right-click the language skin file, then select Open with > Internal Text Editor.

4. In the text editor, enclose your list of stop words in the <StopWords> </StopWords> tag. All
tags are case sensitive and all stop words must be typed in lowercase.

5. Enclose each stop word in the <Word></Word> tag.

6. Click to save your work.

NOTE: You can also modify the stop words list using a text editor on your computer, such
as Notepad.
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HOW TO BUILD THE TARGET AND TEST THE CUSTOM STOP WORDS LIST

1. Open the target in your Flare project.

2. Select the Language tab, and choose the appropriate language.

3. Build the target.

4. Perform searches in the output to test if stop words are being found.

NOTE: Stop words are not customizable in HTML5 outputs.
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CHAPTER 5

Search Filter Sets
A filter can be included in the search feature to let users narrow their search based on concepts
that you have inserted into topics. Concepts are simply markers that you add to topics that have
some kind of relationship with each other. They are also used for inserting concept links into topics.

This chapter discusses the following:

Adding Search Filter Set Files to Projects 43

Inserting Concepts 45

Creating Search Filters 49

Customizing Search Filter Ordering 51

Associating a Search Filter Set with a Target 52

Importing Search Filter Sets 53

Opening a Search Filter Set 54

Search Filter Set Example 55

NOTE: Search filters are not supported in Elasticsearch.
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Adding Search Filter Set Files to Projects
Supported In:

The first step to using a search filter set is to add a special file for it to your project. A search filter
set file has an .flsfs extension and is stored in the Project Organizer under the Advanced folder.

HOW TO ADD A SEARCH FILTER SET TO A PROJECT

1. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select the Project ribbon. In the Content section select New > Advanced > Search
Filter Set.

n Right-Click In the Project Organizer, right-click on the Advanced folder and from the con-
text menu select Add Search Filter Set.

The Add File dialog opens.

2. In the File Type field at the top, make sure Search Filter Set is selected.

3. In the Source area select one of the following:

n New from template Choose either the factory template file or one of your own cus-
tomized template files as a starting point. The new file will take on all of the settings con-
tained in the template. If you want to use the factory template provided by Flare, expand
the Factory Templates folder and click on a template file. If you want to use your own cus-
tomized template file, expand the appropriate folder and click on a file. For more inform-
ation about templates, see the online Help.

n New from existing Choose an existing file of the same type as a starting point for your
new file. As with template files, your new file will take on all of the settings contained in
the file you select. To use this option, click the browse button , use the Open File dia-
log to find a file, and double-click it.

4. (Optional) If you want to place the file into a subfolder previously created in the Project Organ-
izer, in the Folder field click and select the subfolder. Otherwise, keep the default loc-
ation.

5. In the File Name field, type a new name for the search filter set.
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6. (Optional) If you want to apply condition tags to the file, expand the Attributes section at the
bottom of the dialog. Next to the Condition Tags field, click and select the conditions you
want to apply. Click OK.

7. (Optional) If you want to apply file tags, expand the Attributes section at the bottom of the dia-
log. Next to the File Tags field, click and select the file tags you want to apply. Click OK.

8. Click Add. The search filter set is added to the Advanced folder in the Project Organizer. The
Search Filter Set Editor opens to the right, with an initial search filter entry shown.

After you add the new search filter set, you need to insert concepts into topics (if you have not
already done so). After that, you can create search filters based on the concepts that you inserted.
See "Inserting Concepts" on the next page.
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Inserting Concepts
There are a few different ways to insert a concept into a topic or snippet, and each has its own
advantages.

Drag-and-Drop Method
Use this method to quickly insert a concept that already exists in your project.

n Advantage It is extremely fast.

n Disadvantage The concept that you want to insert must already exist in the project. This means
you must first insert the concept into a topic using one of the other methods.

HOW TO INSERT A CONCEPT USING THE DRAG-AND-DROP METHOD

1. Open the content file (e.g., topic, snippet).

2. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select the View ribbon. In the Reference section select Concept Window.

n Keyboard Shortcut Press SHIFT+F9.

The Concept window pane opens. The window pane is split into two sections—the Terms area
at the top and the Explorer area at the bottom. If you want to see more or less of either sec-
tion, you can click the splitter between them and drag it up or down.

3. In the bottom (explorer) area of the Concept window pane, click the concept and drag it to the
location in the topic where you want to insert it. As you drag the concept into the topic, a ver-
tical red bar acts as a guide to help you place the concept in the topic. The concept is dis-
played within a marker in front of the word where you added it (as long as markers are turned
on). A marker can hold multiple concepts, but most times you only need one concept per
marker.

4. Click to save your work.
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Concept Window Pane Method
Use this method to insert a concept in the Concept window pane.

n Advantage It lets you continue to perform other tasks in the topic without having to "switch
modes."

n Disadvantage It is not quite as fast as the other methods.

HOW TO INSERT A CONCEPT USING THE CONCEPT WINDOW PANE METHOD

1. Open the content file (e.g., topic, snippet).

2. Click at the location where you want to insert a concept.

3. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select the View ribbon. In the Reference section select Concept Window.

n Keyboard Shortcut Press SHIFT+F9.

The Concept window pane opens.

4. Click in an empty field in the Terms column.

5. Type the concept as you want it to appear.

6. Press Enter. The concept is displayed within a marker in front of the word where you added it
(as long as markers are turned on). A marker can hold multiple concepts, but most times you
only need one keyword per topic.

7. Click to save your work.
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Concept Entry Mode Method
Use this method to accomplish the same thing as the Concept window pane method. The dif-
ference is that, with this method, you do not need to move your cursor from the topic to the
Concept window pane. You simply click at the spot in the text where you want to insert the keyword
and start typing. The words you type are added directly into the Concept window pane. This is a
good method to use if you plan to create concepts in a lot of topics all at once, without performing
any other tasks in the topic.

n Advantage It is extremely fast.

n Disadvantage If you are adding a concept as you work on a topic, you need to remember to
switch off the Concept Entry Mode so that you can return to editing your topic.

HOW TO INSERT A CONCEPT USING THE CONCEPT ENTRY MODE METHOD

1. Open the content file (e.g., topic, snippet).

2. In the local toolbar of the XML Editor click .

3. Click at the place in your topic where you want to add a concept.

4. Type the phrase that you want to add as the concept.

As you start typing, the Concept window pane opens (if it was not previously opened), and the
phrase is added to the first empty field under the Terms column.

NOTE: As you type in the Concept window pane, notice that the cursor does not lose
focus in the XML Editor. It merely turns gray so that you know for certain where you
are adding the concept. When you return to the XML Editor, the cursor returns to its
previous state.

5. Press Enter. The concept is displayed within a marker in front of the word where you added it
(as long as markers are turned on). A marker can hold multiple concepts, but most times you
only need one keyword per topic.

6. If you want to add more concepts in the topic, repeat steps 3-5.

7. Click to save your work.

To turn off the Concept Entry Mode and return to regular editing, you can click again.

CHAPTER 5  47



NOTE: If you want to see all of the concepts that you have inserted in your project, they are
displayed in the bottom portion of the Concept window pane.
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Creating Search Filters
After you add a new search filter set and insert concepts into topics, you can create search filters,
which let users narrow their search based on concepts that you have inserted into topics.

HOW TO CREATE A SEARCH FILTER

1. Open the Project Organizer.

2. Double-click the Advanced folder. Any search filter sets that you have added are listed.

3. Double-click the search filter set in which you want to create a search filter. The Search Filter
Set Editor opens to the right. By default, Flare provides you with an initial search filter called
"subset," which you can rename and use.

4. To create a new search filter, click in the local toolbar. A new search filter row is added,
with a temporary name for the search filter.

5. To enter a new name or comment for a search filter, do one of the following.

n Double-click in the appropriate cell and type the name or comment.

n Click once in the appropriate cell and press F2 on your keyboard. Then type the name or
comment.

6. To associate a concept with the search filter, click the Concepts cell. The Select Concepts
for Search Filter dialog opens. The concepts that you have inserted into topics are listed on
the right side of the dialog.

7. In the All Concepts section, click on a concept that you want to add to the search filter. Then
click .

The concept is added to the "Selected Concepts" section on the right side of the dialog. Do
this for each concept that you want to add to the search filter.

NOTE: If you do not associate a concept with the search filter, the search filter will
not appear in your output.

8. Click OK.

9. Click to save your work.
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NOTE: You can create search filters for merged projects in WebHelp, DotNet, and HTML 5
output. However, when you merge projects, ordered search filter sets are separated by pro-
ject in the output. To control the order of the search filters from all of your merged projects,
you can create an external resources folder that all the projects share and put the search fil-
ter set in that folder.
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Customizing Search Filter Ordering
Supported In:

By default, search filters display alphabetically. However, you can customize the ordering of the
search filter set so they display in the order that is most useful for your audience.

HOW TO CUSTOMIZE SEARCH FILTER ORDERING

1. Open the Project Organizer.

2. Double-click the Advanced folder. Any search filter sets that you have added are listed.

3. Double-click the search filter set you want to customize. The Search Filter Set Editor opens to
the right. The Order column represents the order displayed in the output.

4. In the Filter Name column, select the filter you want to move.

5. To customize the order of the filters, do one of the following:

n Click or in the local toolbar.

n Select Move Up or Move Down from the context menu.

6. (Optional) To reset the search filters to alphabetical order, click .

7. Click to save your work.
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Associating a Search Filter Set with a Target
After you create search filters, you need to associate the search filter set with the target that you
want to build.

HOW TO ASSOCIATE A SEARCH FILTER SET WITH A TARGET

1. Open the target that you plan to build.

2. In the Target Editor, click the Advanced tab.

3. Click the drop-down arrow in the Filter File field, and select the search filter set that you want
to associate with the target.

4. Click to save your work.
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Importing Search Filter Sets
Not only can you add new search filter sets, but you can also import an existing search filter set
(FLSFS file).

HOW TO IMPORT A SEARCH FILTER SET

1. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select the Project ribbon. In the Content section select New > Advanced > Search
Filter Set.

n Right-Click In the Project Organizer, right-click on the Advanced folder and from the con-
text menu select Add Search Filter Set.

The Add File dialog opens.

2. Select New from existing and click .

3. Find and select the FLSFS file that you want to import.

4. Click Open. The Source File field now contains the path to the file that you are importing. Also,
the name of the file is displayed in the File Name field.

5. If you want to give the search filter set a different name than that for the imported file, click in
the File name field and replace the text.

6. (Optional) If you want to apply condition tags to the file, expand the Attributes section at the
bottom of the dialog. Next to the Condition Tags field, click and select the conditions you
want to apply. Click OK.

7. (Optional) If you want to apply file tags, expand the Attributes section at the bottom of the dia-
log. Next to the File Tags field, click and select the file tags you want to apply. Click OK.

8. Click Add. The search filter set is added and opens in the Search Filter Set Editor.
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Opening a Search Filter Set
The following steps show you how to open a search filter set that you have added to your project.

HOW TO OPEN A SEARCH FILTER SET FROM THE QUICK LAUNCH BAR

The Quick Launch bar allows you to search for any Flare file or command. It is located in the upper-
right corner of the interface. You can press CTRL+Q on your keyboard to move focus to the Quick
Launch bar so you can begin typing.

1. In the Quick Launch bar, type a few letters of the name of the file you want to open. Any avail-
able results appear in a drop-down list.

2. From the list, click the name of the file.

HOW TO OPEN A SEARCH FILTER SET FROM THE PROJECT ORGANIZER

1. Open the Project Organizer.

2. Double-click the Advanced folder. The search filter sets in your project are displayed.

3. Double-click the search filter set that you want to open. The Search Filter Set Editor opens to
the right.
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Search Filter Set Example
Concepts and search filters might seem a little confusing to you at first. The following example is
designed to help make these ideas clearer and guide you through the steps for creating your own
search filter by using concepts.

Scenario
Let's say we have a Flare project called "Pets." In this project, we have dozens of topics about all
kinds of animals (cats, dogs, parrots, hamsters, and so on). We have written five topics about dogs.
These are:

n Choosing a Dog

n Feeding a Dog

n Training a Dog

n Grooming a Dog

n Walking a Dog

We want our users to be able to search for information about dogs. However, we want to limit their
search to these five topics (so that they aren't bothered with seeing search results in other "non-
dog" topics). We'll use a concept to tie our five "dog" topics together, and then we'll customize the
search feature to include this concept.
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Step 1—Create and Insert a Concept
First, we need to create a concept to tie these five topics together. We can create a concept with
any name that we want, but it helps to name the keyword something that is obvious and all topics
have in common. Therefore, we'll give our concept the name "dogs."

1. Open any of the five topics. In this example, we'll open the topic "Choosing a Dog."

2. Click in the location in the topic where you want to insert the concept. Typically, you'll insert
the concept somewhere near the top of the topic. In our example, we will click right before
our topic title "Choosing a Dog."

3. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select the View ribbon. In the Reference section select Concept Window.

n Keyboard Shortcut Press SHIFT+F9.

The Concept window pane opens.

4. The cursor should already be placed in the Terms cell. If not, click in that cell. Then type dogs
and press Enter. A concept marker labeled "dogs" is added before the topic title. If you cannot
see the marker, you need to turn your markers on by clicking the down arrow next to the Show

tags button in the XML Editor. Then select Show Markers.
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Step 2—Copy and Paste the Concept Marker into All
Relevant Topics
Next, we need to place the same concept marker in our other four "dog" topics. We could repeat the
same steps above for each topic, but we'll copy and paste our first concept marker instead.

1. In the "Choosing a Dog" topic, click on the concept marker and choose Select.

2. Press CTRL+C on your keyboard.

3. Open another "dog" topic ("Feeding a Dog," "Training a Dog," etc.). Click in front of the topic
title (or somewhere near the top of the topic), and press CTRL+V on your keyboard. Repeat
this until you've pasted the concept marker into all five of the "dog" topics.

Step 3—Add a Search Filter Set and Create a Filter
Now that we have the concepts in place, we can create a search filter for the "dog" topics.

1. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select the Project ribbon. In the Content section select New > Advanced > Search
Filter Set.

n Right-Click In the Project Organizer, right-click on the Advanced folder and from the con-
text menu select Add Search Filter Set.

The Add File dialog opens.

2. Click Add. The search filter set is added to the Advanced folder in the Project Organizer. The
Search Filter Set Editor opens to the right, with an initial search filter entry shown.

3. Click in the cell under the Filter Name column until "My Subset" is highlighted. Type Dog Top-
ics and press Enter.

4. Click in the cell under the Concepts column. The Select Concepts for Search Filter dialog
opens.

5. In the Selected Concepts section, double-click dogs. The concept is added to the "All Con-
cepts" section on the left side of the dialog.

6. Click OK.

7. Click to save your work.
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Step 4—Customize Search Filter Ordering
If you have created multiple search filters, you can rearrange them to best suit the needs of your
audience (in web outputs). By default, they are alphabetical, but you want to move the "dog" filter to
the top of the list.

1. Open the Project Organizer.

2. Double-click the Advanced folder. Any search filter sets that you have added are listed.

3. Double-click the search filter set you want to customize. The Search Filter Set Editor opens to
the right. The Order column represents the displayed order in the output.

4. In the Filter Name column, select the "dog" filter.

5. To customize the order of the filters, do one of the following:

n Click or in the local toolbar.

n Select Move Up or Move Down from the context menu.

6. (Optional) To reset the search filters to alphabetical order, click .

7. Click to save your work.

Step 5—Associate the Search Filter Set with a Target
Finally, we need to make sure the search filter set that we created is associated with the target that
we plan to build.

1. Open the target that you plan to build.

2. In the Target Editor, click the Advanced tab.

3. Click the drop-down arrow in the Filter File field, and select the search filter set that you want
to associate with the target.

4. Click to save your work.

Now when people use the search feature in our output, they can select "Dog Topics" from the Filter
field to limit their search to our five "dog" topics.

NOTE: Search filters are not supported in Elasticsearch.
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CHAPTER 6

Synonyms
Supported In:

If users enter search phrases in your online output and those phrases are not returning results, this
does not need to be the end of the story. You can make improvements to your output so that, in the
future, users are able to find the search results they need. One way to make an enhancement is to
add the information that your users are looking for (if that information does not yet exist in your
Flare project). Another way to enhance your output is to create synonyms for search phrases.

You can create synonyms within the Flare project, with the browser Admin for Pulse, or within Feed-
back Explorer. It is not mandatory that you have MadCap Pulse or Feedback in order to use syn-
onyms in Flare output, but using MadCap Pulse or Feedback makes it much easier to determine
which words require synonyms based on the search results of your users. Using the browser Admin
for Pulse or the Feedback Explorer to create synonyms is appealing because the synonyms become
immediately available for users searching in your output (without needing to republish the output).
Be aware, however, that creating synonyms in Pulse or Feedback Explorer works for the output as
long as you continue to publish output to the same server. If you create synonyms in Pulse or Feed-
back Explorer, it is recommended that you also create those synonyms at the source (i.e., within the
Flare project), in case you ever publish to a different server. The easiest way to do this is to export
the synonym file from the browser Admin for Pulse or the Feedback Explorer to the Pro-
ject\Advanced folder in the Flare project.
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EXAMPLE

Let's say that you view search keyword results from your users and find that many are
entering the search term "sofa." Unfortunately, you have not used that word in your pro-
ject, so users are unable to find the topics that they need. However, you have used a
similar word, "couch." Therefore, in the Synonyms Editor, you enter "couch" as a syn-
onym for "sofa." The next time a reader enters "sofa" as a search keyword, topics con-
taining the word "couch" will be returned in the results.

This chapter discusses the following:

Tasks for Using Synonyms 61

Adding Synonym Files 62

Creating Synonyms to Enhance Search Results 64

Exporting Synonyms 68

Opening Synonym Files 69
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Tasks for Using Synonyms
Following are the primary tasks in Flare for using synonyms:

n Add Synonym File The first step to creating synonyms for enhanced search is to add a syn-
onym file to the Flare project. See "Adding Synonym Files" on the next page.

n Create Synonyms After adding a synonym file to your project, you can create synonyms
within it. See "Creating Synonyms to Enhance Search Results" on page 64.

n Export Synonym Files If you are using Feedback and have created synonyms, you may want to
export the synonyms file (MCSYNS) to another location. Those synonyms can then be added
to a different Flare project. See "Exporting Synonyms" on page 68.

n Open Synonym Files After a synonym file is created, you can open it at any time to make
adjustments to it. See "Opening Synonym Files" on page 69.

NOTE: After you create synonyms, there is nothing else you need to do in order to make
them available in the output. If you create synonyms in Flare, they are automatically applied
at the project level, so all targets will incorporate those synonyms when you generate and
publish the new Flare output. If you create the synonyms in Pulse or Feedback Explorer
instead, the synonyms become immediately incorporated into the output (even if you do not
republish your Flare target). Please note that if you are testing synonyms in Pulse or Feed-
back Explorer, you may need to refresh the interface to see the changes.

NOTE: Depending on the browser being used, the cache may need to be cleared in order to
see the synonym results.

NOTE: For more information about MadCap Pulse or Feedback, see the online Help.
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Adding Synonym Files
Supported In:

The first step to creating synonyms for enhanced search is to add a synonym file to the Flare pro-
ject.

HOW TO ADD A SYNONYM FILE

1. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select the Project ribbon. In the Content section select New > Advanced > Syn-
onym File.

n Right-Click In the Project Organizer, right-click on the Advanced folder and from the con-
text menu select Add Synonym File.

The Add File dialog opens.

2. In the File Type field at the top, make sure Synonym File is selected.

3. In the Source area select one of the following:

n New from template Choose either the factory template file or one of your own cus-
tomized template files as a starting point. The new file will take on all of the settings con-
tained in the template. If you want to use the factory template provided by Flare, expand
the Factory Templates folder and click on a template file. If you want to use your own cus-
tomized template file, expand the appropriate folder and click on a file. For more inform-
ation about templates, see the online Help.

n New from existing Choose an existing file of the same type as a starting point for your
new file. As with template files, your new file will take on all of the settings contained in
the file you select. To use this option, click the browse button , use the Open File dia-
log to find a file, and double-click it.
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4. (Optional) If you want to place the file into a subfolder previously created in the Project Organ-
izer, in the Folder field click and select the subfolder. Otherwise, keep the default loc-
ation.

5. In the File Name field, type a new name for the synonym file.

6. (Optional) If you want to apply condition tags to the file, expand the Attributes section at the
bottom of the dialog. Next to the Condition Tags field, click and select the conditions you
want to apply. Click OK.

7. (Optional) If you want to apply file tags, expand the Attributes section at the bottom of the dia-
log. Next to the File Tags field, click and select the file tags you want to apply. Click OK.

8. Click Add. The synonym file is added to the Advanced folder in the Project Organizer. The Syn-
onyms Editor opens to the right.

NOTE: You can create synonyms within the Flare project, with the browser Admin for Pulse,
or within Feedback Explorer. It is not mandatory that you have MadCap Pulse or Feedback
in order to use synonyms in Flare output, but using MadCap Pulse or Feedback makes it
much easier to determine which words require synonyms based on the search results of
your users. Using the browser Admin for Pulse or the Feedback Explorer to create syn-
onyms is appealing because the synonyms become immediately available for users search-
ing in your output (without needing to republish the output). Be aware, however, that
creating synonyms in Pulse or Feedback Explorer works for the output as long as you con-
tinue to publish output to the same server. If you create synonyms in Pulse or Feedback
Explorer, it is recommended that you also create those synonyms at the source (i.e., within
the Flare project), in case you ever publish to a different server. The easiest way to do this is
to export the synonym file from the browser Admin for Pulse or the Feedback Explorer to
the Project\Advanced folder in the Flare project.

NOTE: If you merge projects, synonym files will remain separate in each project. For
example, if you create synonyms in Project A but not in project B, only the topics from Pro-
ject A will use the synonyms when users perform searches in the output.
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Creating Synonyms to Enhance Search
Results
Following are steps for creating synonyms.

HOW TO CREATE SYNONYMS

1. Do one of the following to add or open a synonym file:

ADD A SYNONYM FILE

a. If you have not done so already, add a synonym file to the project. Start by selecting Pro-
ject > New > Advanced > Synonym File (if using ribbon view) or Project > Advanced > Syn-
onym File (if using menu view).

b. Enter a name for the synonym file and click Add.

OPEN A SYNONYM FILE

a. Open the Project Organizer.

b. Double-click the Advanced folder.

c. Double-click the synonym file.

2. In the Synonyms Editor, you can create directional synonyms or synonym groups for single
words.

NOTE: The synonyms feature supports the use of single words only. You cannot use
phrases with the synonyms feature. For example, you cannot create a synonym
named "tool bar" for the word "toolbar." An example of a valid use of the synonyms fea-
ture would be to add the synonym "hound" for the word "dog" or "kitty" for the word
"cat."
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SYNONYM GROUP

This is a collection of synonyms that produces the same search results for all of the words in
the group. It is a useful method if you have multiple terms in your project that are similar, and
you want the same search results to be returned when users enter any of those phrases. In
the Synonyms Editor, you enter the terms with an equal sign between each one (Syn-
onym1=Synonym2=Synonym3). When users enter any of those terms in future searches, all
topics containing any of those words are found.

EXAMPLE

Let's say that you have written some content about sports, and many of your
topics include the words "sports," "athletics," or "games." If a user enters the
word "athletics" as the search term, it will return not only topics containing that
word, but also topics containing the words "sports" or "games" (even if "ath-
letics" does not occur in those other topics).

HOW TO CREATE A SYNONYM GROUP

a. Select the Groups tab.

b. Click in the empty Group cell and press F2 on your keyboard.

c. Type the words that you want to include in the group, with an equal sign between each
(e.g., sports=athletics=games). Press Enter when you are finished.

d. (Optional) Click in the Stem check box if you want Flare to find other variations of the
synonyms that have the same stems.example.

EXAMPLE

Let's say you enter "hike=walk" in the Group cell. Then you select the Stem
check box. In the future, if users search for the word "hike," it will find all top-
ics containing the words "hike" or "walk." However, it will also find topics
containing words that have the same stem as those terms, such as "hiked,"
"hiking," or "walking."
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DIRECTIONAL SYNONYM

This is a synonym that works in one direction (Word—>Synonym). It is a useful method if read-
ers enter a search term that is not contained in your project, but you have a similar word that
is contained in the project. It works like this… In the Synonyms Editor, you enter the word that
is not producing search results (because it is NOT contained in your project content). Next to
it, you enter a synonym—a word that will produce search results (because it IS contained in
your project content). When users enter the original word again in future searches, topics con-
taining the synonym are found.

EXAMPLE

Let's say that you use MadCap Pulse to view search keyword results from your
users and find that many are entering the search term "sofa." Unfortunately,
you have not used that word in your project, so users are unable to find the top-
ics that they need. However, you have used a similar word, "couch." Therefore,
in the Synonyms Editor, you enter "couch" as a synonym for "sofa." The next
time a reader enters "sofa" as a search keyword, topics containing the word
"couch" will be returned in the results.
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HOW TO CREATE A DIRECTIONAL SYNONYM

a. Select the Directional tab.

b. Click in the empty Word cell and press F2 on your keyboard.

c. Type the phrase that does not produce search results (e.g., sofa). Press Enter.

d. Click in the empty Synonym cell and press F2 on your keyboard.

e. Type the parallel search phrase that is contained in the project content (e.g., couch).
Press Enter when you are finished. In the future, when users perform a search and
enter the term from the Word cell (e.g., sofa), Flare will find all topics that contain the
term that you entered in the Synonym cell (e.g., couch).

f. (Optional) Click in the Stem check box if you want Flare to accept other variations of the
search term that have the same stem.

EXAMPLE

Let's say you enter "hike" in the Word cell, and you enter "walk" in the Syn-
onym cell. Then you select the Stem check box. In the future, if users
search for the word "hike," it will find all topics containing the word "walk."
The same will happen if users enter other search phrases with the same
stem, such as "hiked" or "hiking."

3. Click to save your work.
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Exporting Synonyms
After creating synonyms in a Flare project, you may want to export the synonyms file (MCSYNS) to
another location. Those synonyms can then be added to a different Flare project.

HOW TO EXPORT SYNONYMS

1. Open the Project Organizer.

2. Double-click the Advanced folder.

3. Double-click the synonym file. The Synonyms Editor opens.

4. Select the File drop-down.

5. Click the down arrow on the Save button.

6. Select Save As or Save To.

7. In the Save As dialog, navigate to the folder where you want to save the exported file. If you
want to add the synonym file to another Flare project, you can navigate to the Pro-
ject\Advanced subfolder where that project is stored.

8. In the File name field, enter a name for the synonym file.

9. Click Save.
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Opening Synonym Files
After a synonym file is created, you can open it at any time to make adjustments to it.

HOW TO OPEN A SYNONYM FILE FROM THE QUICK LAUNCH BAR

The Quick Launch bar allows you to search for any Flare file or command. It is located in the upper-
right corner of the interface. You can press CTRL+Q on your keyboard to move focus to the Quick
Launch bar so you can begin typing.

1. In the Quick Launch bar, type a few letters of the name of the file you want to open. Any avail-
able results appear in a drop-down list.

2. From the list, click the name of the file.

HOW TO OPEN A SYNONYM FILE FROM THE PROJECT ORGANIZER

1. Open the Project Organizer.

2. Double-click the Advanced folder.

3. Double-click the synonym file.The Synonyms Editor opens to the right.
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CHAPTER 7

Search Highlighting and Styles
There are a few ways you can control the look of search results. This includes search highlighting
and styles that provide a look for results pages.

This chapter discusses the following:

Search Highlighting 71

Customizing Highlighted Search Terms 72

Styles for Generated Pages 76
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Search Highlighting
Supported In:

When users initiate a search query, the search hits (i.e., the matching keywords and phrases) may
be highlighted when the individual topics are opened. This feature is called "search highlighting" and
it is supported for simple text search and phrase search. Note that when searching with wildcard
characters, the search feature will not apply highlighting to search hits.

Online output types use a highlight color when revealing search hits.

In Eclipse Help, search highlighting is provided by the Eclipse platform and cannot be changed using
Flare.

For other online output types, you can customize the available colors using Flare. See "Customizing
Highlighted Search Terms" on the next page.

Output Type Customize Up to 10 Highlight Colors?

DotNet Help

Microsoft HTML Help

HTML51

WebHelp

WebHelp AIR

WebHelp Mobile

WebHelp Plus

1Tripane output shows highlights words in color by default. In Side and Top Navigation outputs, search results
are transparent, but you can customize this, adding colors.
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Customizing Highlighted Search Terms
When users perform searches in your online output, the keywords that are found may be highlighted
in the topics. The background for each term found in a topic can be highlighted in a different color.
In Flare you can use styles to change not only the color background, but other settings as well (e.g.,
font style, text decoration).

Customizing the highlight color for search hits is useful when you want to coordinate the visual ele-
ments of your online target with a color palette or scheme. It can also be used to improve the
accessibility of your documentation. For example, if you are developing a project for an audience
with impaired vision, you might want to customize the search highlighting to provide users with a
higher color contrast.

For most types of output, you can customize the highlight color using span styles (e.g.,
span.SearchHighlight1, span.SearchHighlight2) in a regular stylesheet. For HTML5 Tripane output,
this is done in the Skin Editor instead.

EXAMPLE

Let's say that you have the following three classes: span.SearchHighlight1,
span.SearchHighlight2, and span.SearchHighlight3. For span.SearchHighlight1, you
change the background color to blue. For span.SearchHighlight2, you change the back-
ground color to orange. And for span.SearchHighlight3, you change the background
color to yellow.

If a user enters "topic information help find" in the search field, the term "topic" will be
displayed with a blue background everywhere it occurs in a topic. The term "inform-
ation" will be displayed with an orange background, and the term "help" will be displayed
with a yellow background. The term "find" will be displayed with the default background
color specified by Flare (since you did not change it).

If another user enters "help find topic information" in the search field, the term "help"
will be displayed with a blue background. The term "find" will be displayed with an
orange background, and the term "topic" will be displayed with a yellow background.
The term "information" will be displayed with the default background color specified by
Flare (since you did not change it).
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HOW TO USE STYLES TO CHANGE THE STYLE OF HIGHLIGHTED SEARCH TERMS

1. From the Content Explorer, open the stylesheet that you want to modify.

2. In the local toolbar, make sure the first button displays . If the button displays

instead, then click it.

NOTE: For steps using the Simplified view, see the online Help.

3. In the upper-left corner of the editor, click in the drop-down field and select
.

4. (Optional) If you have an older stylesheet that does not yet contain the appropriate span
classes you need for search highlighting, you can create them. You can do this for a main
"SearchHighlight" class, as well as for the first 10 terms that users enter in the search field,
naming each class "span.SearchHighlight1," "span.SearchHighlight2," and so on until you cre-
ate "span.SearchHighlight10." The easiest way to create these classes is to import them from
a Flare factory stylesheet, but you can also create them manually.

TO IMPORT THESE CLASSES FROM A FLARE FACTORY STYLESHEET

i. In the local toolbar, click the Options button and select Import Styles. The Import Styles
dialog opens.

ii. In the Library Folders section, make sure Factory Stylesheets is selected.

iii. In the Stylesheets section, select SearchHighlight.

iv. (Optional) In the [Medium] drop-down list, you can select a specific medium. This determ-
ines the medium to which the styles are imported in your current stylesheet. If you select
"default," the imported style properties will be applied to all of the mediums in the other
stylesheet. If you select a custom medium, the imported style properties will be imported
to that medium in the other stylesheet.

v. In the section below, click the Import check box next to each style class named
span.SearchHighlight followed by a number. There are 10 of these style classes.

vi. Click OK. The style classes are added to the current stylesheet.
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TO CREATE THESE CLASSES MANUALLY

i. In the Styles section on the left side of the editor, select the span tag.

ii. In the local toolbar, click . The New Selector dialog opens.

iii. Enter SearchHighlight1 (or replace 1 with another number at the end, up to 10).

iv. Click OK.

5. Select the style class that you want to modify. If you select the main SearchHighlight class,
the same color will be used for all search terms found. Otherwise, you can select a numbered
SearchHighlight class (e.g., SearchHighlight1, SearchHighlight2) to set individual colors for dif-
ferent terms found.

6. From the Show drop-down list on the upper-right side of the editor, select .

7. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .

8. If you are using the group view, expand a property group for the property that you want to
change. Not only can you change the background color, but you can change any other prop-
erty for the class as well. The property name is shown on the left. The right side is used for
selecting and entering values.

9. Click in the value column on the right side. Depending on the type of property, you can either
type the value, select it from a drop-down list, click a button, or complete the values in a dialog
or popup. If you completed values in a popup, click OK at the bottom of the box.

EXAMPLE

Let's say that you want to change the background color for the class
span.SearchHighlight1. After you select that class on the left you can double-
click the Background property group on the right side of the editor. Then in the
cell to the right of background-color, click the down arrow and choose the color
you want.

10. Click to save your work.
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HOW TO CUSTOMIZE SEARCH HIGHLIGHT COLORS—HTML5 TRIPANE ONLY

Use the following steps if you are creating HTML5 Tripane output. If you are creating HTML5 Side
Navigation, Top Navigation, or skinless output, use the steps above for doing this in a stylesheet.

1. In the Project Organizer, open the Skins folder.

2. Open the desired HTML5 Tripane skin.

3. In the Skin Editor, click the Styles tab.

4. On the left side of the editor, in the Search Results section, expand the Search Highlight style.

5. If you want the setting(s) to be applied to all of the items, complete the fields under the main
Search Highlight style itself. Otherwise, expand any of the child styles (Search Highlight 01 to
10) to apply settings to them individually. Each search highlight style is numbered to coordin-
ate with the order search terms are entered. For example, the style named "Search Highlight
01" will be used for matches to the first search term entered and "Search Highlight 10" would
coordinate with the tenth entered term. You can customize up to 10 highlight colors.

6. Click to save your work.

NOTE: Search highlighting for Eclipse Help is provided by the Eclipse platform. Highlight col-
ors for search cannot be modified in Flare.
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Styles for Generated Pages
Supported In:

Sometimes your output may display content that is entirely auto-generated, rather than pulling con-
tent from one of your topics. This occurs when search results are displayed. It also occurs if your
output is integrated with MadCap Pulse and a user clicks the Edit User Profile button, which then dis-
plays information on the Pulse home page, with no topic content shown.

Style Classes
For HTML5 Side and Top Navigation (and skinless outputs), you can add the following classes of the
html style to control the look of these generated pages:

n pulseTopic This style class controls the look of a generated Pulse page (i.e., page opened via
the Edit User Profile button).

n searchTopic This style class controls the look of a generated search results page.

n templateTopic This style class controls the look of all generated pages and has precedence
over the other the pulseTopic and searchTopic classes.
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EXAMPLE

Let's say you want Pulse-generated pages to show a yellow background. So you add a
class to html, name it pulseTopic, and set the background color to yellow.

On the page showing search results, you want the background color to be light blue. So
you add a class to html, name it searchTopic, and set the background color to light
blue.

When you view those pages in the output, the background colors are just as you spe-
cified.
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But then let's say you add a class to html, name it templateTopic, and set the back-
ground color to light red.

As a result, the yellow and blue background colors will be overridden. Both kinds of gen-
erated pages will display with a light red background.
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Suggested Style Setting
If you include a side menu—via a Menu proxy—that is not context-sensitive, this menu may display
on generated pages, not just in regular topics. This is probably something you want to avoid.

Therefore, to prevent this issue, you may want to copy the following to your stylesheet via the
Internal Text Editor.

html.templateTopic div.sideContent
{

display: none;
}

NOTE: These styles are supported only in HTML5 Side Navigation, Top Navigation, and skin-
less outputs. They are not supported in HTML5 Tripane output.
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CHAPTER 8

HTML5 Server-based Output
You can enable server-based output for HTML5 targets. This allows for searching of non-XHTML
content.

This chapter discusses the following:

Enabling HTML5 Server-based Output 81

Installing IIS and ASP.NET 82

Setting Up an HTML5 Target 91

Configuring IIS on Production Server 92

Starting Microsoft Indexing Service 94

Starting Microsoft Windows Search 95

Enabling HTML5 Server-based Search 96

Testing HTML5 Server-based Search 97

Including Non-XHTML Files in HTML5 Search 98
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Enabling HTML5 Server-based Output
You can create HTML5 output in its regular state, or you can select an option in the Publishing tab of
the Target Editor to enable server-based functionality. This allows you to accomplish the same res-
ults as WebHelp Plus output—server-side search and searching of non-XHTML content.

If you want to take advantage of the advanced server-side features of HTML5 (i.e., automatic
runtime project merging, server-side search, searching of non-XHTML files), you must enable
HTML5 server-based output. This includes performing the following tasks: (1) installing Microsoft
Internet Information Services (IIS) and ASP.NET, (2) setting up the HTML5 target and gen-
erating/publishing, (3) configuring IIS on the production server, (4) starting Microsoft Indexing Ser-
vice or Microsoft Windows Search (depending on the operating system), and (5) enabling HTML5
search.

It is not necessary to install these in order to simply build HTML5 server-based output. However, if
you want to be able to view and display HTML5 server-based output, the following steps are neces-
sary. You must perform these steps on the machine that will be hosting the published HTML5
server-based output. If you want to view the output on your local machine to test the results, then
you also need to perform these steps on your local computer, except for the procedure "Configuring
IIS on Production Server."
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Installing IIS and ASP.NET
The following steps show you how to install IIS and ASP.NET, depending on the operating system.

WINDOWS 8

The following steps show you how to install IIS and ASP.NET 4.5 for Windows 8.

INSTALLING IIS

1. Open the Control Panel. On many computers, you can do this by clicking Start > Control Panel.

2. Select Programs and Features.

3. Click Turn Windows features on or off.

4. Select Internet Information Services.

5. Expand Internet Information Services > Web Management Tools > IIS 6 Management Com-
patibility.

6. Click IIS Metabase and IIS 6 configuration compatibility.

INSTALLING ASP.NET 4.5

1. Under Internet Information Services expand World Wide Web Services.

2. Expand Application Development Features.

3. Click the check box next to ASP.NET 4.5 to add a check mark.

4. Click OK.
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WINDOWS 7

The following steps show you how to install IIS and ASP.NET for Windows 7.

INSTALLING IIS

1. Open the Control Panel. On many computers, you can do this by clicking Start > Control Panel.

2. Select Programs and Features.

3. Click Turn Windows features on or off.

4. Select Internet Information Services.

5. Expand Internet Information Services > Web Management Tools > IIS 6 Management Com-
patibility.

6. Click IIS 6 Metabase and IIS 6 configuration compatibility.

INSTALLING ASP.NET

1. Under Internet Information Services expand World Wide Web Services.

2. Expand Application Development Features.

3. Click the check box next to ASP.NET to add a check mark.

4. Click OK.

5. Click Start.

6. In the search field enter run.

7. Click Run. The Run dialog opens.

8. In the Open field, copy and paste one of the following into the field, depending on whether you
have a 32-bit or 64-bit system:

32-BIT

C:\WINDOWS\Microsoft.NET\Framework\v4.0.30319\aspnet_regiis -i

64-BIT

C:\WINDOWS\Microsoft.NET\Framework64\v4.0.30319\aspnet_regiis -i

9. Click OK.
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A window opens, displaying the installation progress of ASP.NET. The window will close auto-
matically when the installation finishes.
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WINDOWS SERVER 2012

The following steps show you how to install IIS and ASP.NET 4.5 for Windows Server 2012.

INSTALLING IIS

1. Open the Server Manager.

2. Click Add roles and features. The Add Roles and Features Wizard opens.

3. Click Next two times until you ge to the Server Roles page.

4. Click the check box next to Web Server (IIS).

5. In the dialog that opens click Add Features.

INSTALLING ASP.NET 4.5

1. In the Add Roles Wizard click Next.

2. Expand .NET Framework 4.5 Features and click ASP.NET 4.5.

3. Click Next.

4. At the Web Server Role (IIS) tab, click Next again.

5. Expand Management Tools > IIS 6 Management Compatibility and click IIS 6 Metabase Com-
patibility.

6. On the Confirm Installation Selections page of the wizard, click Install.

7. After the installation is completed, the Installation Results page opens. Click Close.
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WINDOWS SERVER 2008 R2

The following steps show you how to install IIS and ASP.NET for Windows Server 2008 R2.

INSTALLING IIS

1. From the Start menu open the Server Manager dialog.

2. Click Add roles. The Add Roles Wizard opens.

3. Click Next.

4. Click the check box next to Web Server (IIS).

5. In the dialog that opens click Add Required Features.

6. In the Add Roles Wizard click Next.

7. Click Next again.

8. On the "Select Role Services" page of the wizard, expand Management Tools > IIS 6 Man-
agement Compatibility and click IIS 6 Metabase Compatibility.

9. On the Confirm Installation Selections page of the wizard, click Install.

10. After the installation is completed, click Finish.

INSTALLING ASP.NET

1. In the Server Manager dialog, expand Roles.

2. Select Web Server IIS.

3. In the Role Services section, click Add Role Services.

4. Click the check box next to ASP.NET to add a check mark.

5. Click Next.

6. Click Install.

7. Click Close.

8. In the search field enter run.

9. Click Run.The Run dialog opens.
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10. In the Open field, copy and paste one of the following into the field, depending on whether you
have a 32-bit or 64-bit system:

32-BIT

C:\WINDOWS\Microsoft.NET\Framework\v4.0.30319\aspnet_regiis -i

64-BIT

C:\WINDOWS\Microsoft.NET\Framework64\v4.0.30319\aspnet_regiis -i

11. Click OK.

A window opens, displaying the installation progress of ASP.NET. The window will close auto-
matically when the installation finishes.
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WINDOWS SERVER 2008

The following steps show you how to install IIS and ASP.NET for Windows Server 2008.

INSTALLING IIS

1. From the Start menu open the Server Manager dialog.

2. Click Add roles. The Add Roles Wizard opens.

3. Click Next.

4. Click the check box next to Web Server (IIS).

5. In the dialog that opens click Add Required Features.

6. In the Add Roles Wizard click Next.

7. Click Next again.

8. On the "Select Role Services" page of the wizard, expand Management Tools > IIS 6 Man-
agement Compatibility and click IIS 6 Metabase Compatibility.

9. On the Confirm Installation Selections page of the wizard, click Install.

10. After the installation is completed, click Finish.

INSTALLING ASP.NET

1. In the Server Manager dialog, expand Roles.

2. Select Web Server IIS.

3. In the Role Services section, click Add Role Services.

4. Click the check box next to ASP.NET to add a check mark.

5. Click Next.

6. Click Install.

7. Click Close.
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WINDOWS SERVER 2003

The following steps show you how to install IIS and ASP.NET for Windows Server 2003.

INSTALLING IIS VIA THE MANAGE YOUR SERVER DIALOG

1. From the Start menu open the Manage Your Server dialog.

2. Click Add or remove a role.The Configure Your Server Wizard opens.

3. Click Next.

4. Select Application server (IIS, ASP.NET) and click Next.

5. Click Enable ASP.NET and click Next.Your selections are summarized.

6. Click Next.The Windows Components Wizard opens, displaying the status of the installation.

7. After the installation is completed, click Finish.

INSTALLING IIS VIA THE CONTROL PANEL

1. Open the Control Panel. On many computers, you can do this by clicking Start > Control Panel.

2. Double-click Add or Remove Programs.The Add or Remove Programs window opens.

3. Click Add/Remove Windows Components.The Windows Components Wizard opens.

4. In the list of components select Application Server and then click Details.The Application
Server Dialog opens.

5. Click the check box next to Internet Information Services (IIS) to add a check mark.

6. In the Windows Component Wizard, "Application Server" should now be selected. Click Next.

7. Click Finish.
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INSTALLING ASP.NET

1. Click Start > Run.The Run dialog opens.

2. In the Open field, copy and paste one of the following into the field, depending on whether you
have a 32-bit or 64-bit system:

32-BIT

C:\WINDOWS\Microsoft.NET\Framework\v4.0.30319\aspnet_regiis -i

64-BIT

C:\WINDOWS\Microsoft.NET\Framework64\v4.0.30319\aspnet_regiis -i

3. Click OK.

A window opens, displaying the installation progress of ASP.NET. The window will close auto-
matically when the installation finishes.

NOTE: ASP.NET pages by default are prohibited in IIS. Therefore, you must set these
pages to be allowed if you are running Windows Server 2003. To do this: (1) In Inter-
net Information Services (IIS) Manager, select Web Service Extensions from the left
pane; (2) in the right pane, make sure that ASP.NET v4.0.30319 is set to Allowed. If it
is not, select it and click the Allow button.
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Setting Up an HTML5 Target
The following steps show you how to set up your HTML5 target for server-based output.

HOW TO SET UP THE HTML5 TARGET

1. In Flare, open the HTML5 target.The Target Editor opens.

2. Select the Publishing tab.

3. In the Server-based Output section, click the check box.

4. In the Indexing Service Catalog Name field, type the catalog that you are using for the output.
In most cases, this will be Web, which is the default value. However, if you or someone in your
company (e.g., network administrator) creates a custom catalog, you need to enter that
name in the field.

What is a catalog? Microsoft Indexing Service stores all of its index information in catalogs. A
catalog comprises index information and stored properties for a particular group of file sys-
tem directories. If Internet Information Services (IIS) is installed, the Indexing Service also cre-
ates a web catalog, which contains an index of IIS, the default virtual server of the World Wide
Web.

NOTE: This step is necessary only for Windows Server 2003.

5. Click to save your work.

6. Generate the target.

7. Publish the output to any location on the web server. If you want to use the default location
that was created after you installed IIS, you can publish the output to C:\Inetpub\wwwroot. If
you do this, you can use the "Default Web Site" folder that you will encounter when performing
the next set of steps (i.e., configuring IIS on the production server).

If you are working on your local machine for testing purposes, you do not need to publish the
output. You can simply view your WebHelp Plus output. When you view HTML5 output on your
local computer, you need to create a special folder called "MCPreview" within your "C:\Inet-
pub\wwwroot" folder. Place a copy of your HTML5 output files in it. This enables you to test
the advanced features of HTML5 on your local machine.
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Configuring IIS on Production Server
The following steps show you how to configure IIS, depending on the operating system. These steps
are necessary only for the server where you will be publishing the final output. It is not necessary to
perform these steps on your local computer for testing HTML5 server-based output.

WINDOWS SERVER 2003

1. Open the Control Panel. On many computers, you can do this by clicking Start > Control Panel.

2. Double-click Administrative Tools.The Administrative Tools dialog opens.

3. Double-click Internet Information Services.The Internet Information Services dialog opens.

4. Find your output folder and right-click the Service subfolder. Then select Properties.The Ser-
vice Properties dialog opens.

5. Select the Virtual Directory tab.

6. Next to the Application name field, click the Create button.

NOTE: If this button has already been selected, it will display as "Remove" instead. In
this case, you do not need to click the button.

7. In the Execute Permissions drop-down, make sure Scripts only is selected. It should already
be selected by default.

8. Click OK.
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WINDOWS SERVER 2008 AND 2008 R2, WINDOWS 2012, WINDOWS 7, AND WINDOWS 8

1. Open the Control Panel.

2. Select System and Security.

3. Select Administrative Tools. The various operating systems have different ways to find this
option.

4. Open the Internet Information Services (IIS) Manager.

5. Expand the node with the computer name.

6. Expand the Sites folder.

7. Expand the website folder corresponding to the one that you published.

8. Find your output folder and right-click the Service subfolder. Then select Convert to Applic-
ation.

9. Make sure the the application pool is using the .NET 4 framework.

a. In the dialog click Select.

b. From the drop-down select an application pool that is using the .NET 4 framework.

c. Click OK.

10. Click OK.
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Starting Microsoft Indexing Service
The following steps show you how to start the Microsoft Indexing Service on machines that are run-
ning Windows Server 2003. This procedure is not necessary for the other operating systems.

1. Open the Control Panel. On many computers, you can do this by clicking Start > Control Panel.

2. Double-click Administrative Tools.The Administrative Tools dialog opens.

3. Double-click Computer Management.The Computer Management dialog opens.

4. Expand Services and Applications.

5. Right-click Indexing Service.

6. In the context menu, click Start. The Indexing Service is now started.
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Starting Microsoft Windows Search
The following steps show you how to start the Microsoft Windows Search on machines that are run-
ning Windows Server 2008. This procedure is not necessary for the other operating systems.

1. From the Start menu open the Server Manager dialog.

2. Click Add roles.The Add Roles Wizard opens.

3. Click Next.

4. Click the check box next to Files Services.

5. Click Next twice.

6. Click the check box next to Windows Search Service.

7. Click Next twice.

8. Click Install.

9. Click Close.
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Enabling HTML5 Server-based Search
The following steps show you how to enable HTML5 server-based search. These steps must be
done for each catalog that you are using on the server (or on your local machine, if you are viewing
HTML5 server-based output on your computer for testing purposes).

1. Navigate to the output folder for the HTML5 target on the server or on your local machine.

If you are enabling HTML5 server-based output on your local machine, you can quickly find
the output folder by doing the following.

a. Open the Project Organizer.

b. Double-click the Targets folder.

c. Right-click on the target and select Open Output Folder.

2. In the output folder, double-click the Service folder.

3. Double-click the folder labeled Console.ConfigureSearch.

4. Double-click ConfigureSearch.exe. A window appears very briefly and then disappears.

5. Create a folder called "AutoMergeCache" at the root of the site. Then you must set security
preferences on the AutoMergeCache folder so the application can create and update files.

a. Right-click on the root folder and choose Explore to open Windows Explorer.

b. Right-click on AutoMergeCache and choose Properties.

c. On the Security tab click the Edit button.

d. Click Add.

i. Type Everyone and click Check Names, making sure it gets underlined.

ii. Click OK.

e. Make sure Everyone is highlighted and check the option for Full Control.

f. Click Apply.

g. Click OK to exit the Permission dialog.

h. Click OK to exit the Properties dialog.
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Testing HTML5 Server-based Search
The following steps are optional for testing HTML5 server-based search (for Microsoft Windows
Search).

1. In IIS right-click on the directory where your HTML5 project is published to and choose
Explore.

2. In the upper-right corner of the window you will see a Search input box. Perform a search for a
term that is commonly found in your project.

3. If you see results, your project is ready to go live.
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Including Non-XHTML Files in HTML5
Search
Supported In:

When end users perform a search in your online output, you can ensure that non-XHTML files (e.g.
PDF, DOC, XLS) are included in that search. The files do not even need to be linked to any of the con-
tent in your Flare project. This feature is available if you publish HTML5 server-based output to a
web server running Microsoft Internet Information Services (IIS).

HOW TO INCLUDE NON-XHTML FILES IN SEARCH

1. Enable HTML5 Server-based Output If you want to take advantage of the advanced server-
side features of HTML5 (i.e., automatic runtime project merging, server-side search, search-
ing of non-XHTML files), you must enable HTML5 server-based output. This includes per-
forming the following tasks: (1) installing Microsoft Internet Information Services (IIS) and
ASP.NET, (2) setting up the HTML5 target and generating/publishing, (3) configuring IIS on
the production server, (4) starting Microsoft Indexing Service or Microsoft Windows Search
(depending on the operating system), and (5) enabling HTML5 search.  For more information
see the online Help.

2. Generate HTML5 Server-based Output In Flare, generate a target using the WebHelp Plus out-
put format.

3. Publish HTML5 Output to Server Publish the HTML5 server-based output to your Microsoft IIS
Web server.

4. (Optional) Add IFilter File types that are automatically supported for HTML5 server-based
search include: Microsoft Office files, HTML files, and TXT files. For other non-supported file
types, such as PDF documents, you can download and install a simple IFilter in order to
include that file type in the search. To find and download the IFilter for the file type that you
want to include, go to a website that provides these (such as http://www.ifilter.org) and follow
the instructions for downloading IFilters. You must install the appropriate IFilters on the server
where the output files will be published, and if you are testing HTML5 server-based output on
your computer, you need to install the IFilter(s) locally as well.

5. Copy and Paste Non-XHTML Files to Appropriate Folder Copy all of the non-XHTML files that

CHAPTER 8  98

http://www.ifilter.org/


you want to be included in the search. Then paste them in the appropriate subfolder of the
HTML5 server-based output that you published. By default, HTML5 server-based will find any
files located in the project output folder, as well as the "AutoSearch" subfolder. Therefore, you
can paste your extra non-XHTML files in the AutoSearch subfolder.

EXAMPLE

http://www.xyzincorporated.com/help systems/MyTargetName/AutoSearch.

However, if there are any other folders where you want either XHTML or non-
XHTML files to be stored (instead of, or in addition to, AutoSearch), you can per-
form some extra steps to allow this.

Let's say you also want searches in the Help system to provide results from files
in the folder C:\ExternalSearchFolder. Here are the steps to allow this:

1. This folder must be accessible by IIS. Therefore, create a virtual directory
in IIS for it. Following are steps for doing this.

a. Open the Control Panel. On many computers, you can do this by click-
ing Start > Control Panel.

b. Double-click Administrative Tools. The Administrative Tools dialog
opens.

c. Double-click Internet Information Services. The Internet Information
Services (IIS) Manager dialog opens.

d. Expand the Web Sites folder.

e. Right-click on the Default Web Site folder and select New > Virtual Dir-
ectory.

f. Click Next.

g. In the Alias field, enter a name for the subfolder (e.g., SearchFolder).

h. Click Next.

i. Click the Browse button, then find and select the folder holding the
content that you want to publish (e.g., C:\ExternalSearchFolder).

j. Click Next.

k. Make sure a check mark is next to Read.
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l. Click Next.

m. Click Finish.

2. Create an XML file called "SearchFolders.xml" and place it in the
"AutoSearch" folder in the HTML5 server-based output directory. The con-
tents of this file will specify any virtual directories that HTML5 should
search. Following is what you would type in the SearchFolders.xml file.
This example specifies just one folder, but you can add references to as
many virtual directories as you need.

<?xml version="1.0" encoding="utf-8"?>
<SearchFolders>

<Url>/SearchFolder</Url>
</SearchFolders>

When users perform a search in your output, those non-XHTML files will also be
scanned and become accessible to the users.
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NOTE: If you are testing WebHelp Plus output on your local machine, you need to view the
output at least one time. When you view HTML5 output on your local computer, you need to
create a special folder called "MCPreview" within your "C:\Inetpub\wwwroot" folder. Place a
copy of your HTML5 output files in it. This enables you to test the advanced features of
HTML5 on your local machine. When testing this search feature on your computer, you
need to place the non-XHTML files in the AutoSearch subfolder at this location (as opposed
to the output folder that was generated where your Flare project is located).

NOTE: If you are testing HTML5 server-based output on your local machine, you may need
to wait a few minutes after viewing the output for the Indexing Service to fully scan your
files. Otherwise, you may not immediately see the effects of the scan (e.g., searches of
non-XHTML files, incorporation of merged output files) in the output. If you avoid per-
forming other tasks during this period, the scanning of the files will be completed more
quickly.

NOTE: If you want to test HTML5 server-based output on your local computer, the
advanced search features of HTML5 are not operable.
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CHAPTER 9

WebHelp Plus Server-based
Output
You can enable server-based output for WebHelp Plus targets. This allows for searching of non-
XHTML content and faster searching.

This chapter discusses the following:

Enabling WebHelp Plus Output 103

Installing IIS and ASP.NET 104

Setting Up a WebHelp Plus Target 113

Configuring IIS on Production Server 115

Starting Microsoft Indexing Service 117

Starting Microsoft Windows Search 118

Enabling WebHelp Plus Search 119

Testing WebHelp Plus Search 120

Including Non-XHTML Files in Search 121
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Enabling WebHelp Plus Output
If you want to take advantage of the advanced server-side features of WebHelp Plus (i.e., automatic
runtime project merging, faster search, server-side search, searching of non-XHTML files), you
must enable WebHelp Plus output. This includes performing the following tasks: (1) installing
Microsoft Internet Information Services (IIS) and ASP.NET, (2) setting up the WebHelp Plus target
and generating/publishing, (3) configuring IIS on the production server, (4) starting Microsoft Index-
ing Service or Microsoft Windows Search (depending on the operating system), and (5) enabling
WebHelp Plus search.

It is not necessary to install these in order to simply build WebHelp Plus output. However, if you want
to be able to view and display WebHelp Plus output, the following steps are necessary. You must per-
form these steps on the machine that will be hosting the published WebHelp Plus output. If you
want to view the output on your local machine to test the results, then you also need to perform
these steps on your local computer, except for the procedure "Configuring IIS on Production
Server."
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Installing IIS and ASP.NET
The following steps show you how to install IIS and ASP.NET, depending on the operating system.

WINDOWS 8

The following steps show you how to install IIS and ASP.NET 4.5 for Windows 8.

INSTALLING IIS

1. Open the Control Panel. On many computers, you can do this by clicking Start > Control Panel.

2. Select Programs and Features.

3. Click Turn Windows features on or off.

4. Select Internet Information Services.

5. Expand Internet Information Services > Web Management Tools > IIS 6 Management Com-
patibility.

6. Click IIS Metabase and IIS 6 configuration compatibility.

INSTALLING ASP.NET 4.5

1. Under Internet Information Services expand World Wide Web Services.

2. Expand Application Development Features.

3. Click the check box next to ASP.NET 4.5 to add a check mark.

4. Click OK.
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WINDOWS 7

The following steps show you how to install IIS and ASP.NET for Windows 7.

INSTALLING IIS

1. Open the Control Panel. On many computers, you can do this by clicking Start > Control Panel.

2. Select Programs and Features.

3. Click Turn Windows features on or off.

4. Select Internet Information Services.

5. Expand Internet Information Services > Web Management Tools > IIS 6 Management Com-
patibility.

6. Click IIS 6 Metabase and IIS 6 configuration compatibility.

INSTALLING ASP.NET

1. Under Internet Information Services expand World Wide Web Services.

2. Expand Application Development Features.

3. Click the check box next to ASP.NET to add a check mark.

4. Click OK.

5. Click Start.

6. In the search field enter run.

7. Click Run. The Run dialog opens.

8. In the Open field, copy and paste one of the following into the field, depending on whether you
have a 32-bit or 64-bit system:

32-BIT

C:\WINDOWS\Microsoft.NET\Framework\v4.0.30319\aspnet_regiis -i

64-BIT

C:\WINDOWS\Microsoft.NET\Framework64\v4.0.30319\aspnet_regiis -i

9. Click OK.
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A window opens, displaying the installation progress of ASP.NET. The window will close auto-
matically when the installation finishes.
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WINDOWS SERVER 2012

The following steps show you how to install IIS and ASP.NET 4.5 for Windows Server 2012.

INSTALLING IIS

1. Open the Server Manager.

2. Click Add roles and features. The Add Roles and Features Wizard opens.

3. Click Next two times until you ge to the Server Roles page.

4. Click the check box next to Web Server (IIS).

5. In the dialog that opens click Add Features.

INSTALLING ASP.NET 4.5

1. In the Add Roles Wizard click Next.

2. Expand .NET Framework 4.5 Features and click ASP.NET 4.5.

3. Click Next.

4. At the Web Server Role (IIS) tab, click Next again.

5. Expand Management Tools > IIS 6 Management Compatibility and click IIS 6 Metabase Com-
patibility.

6. On the Confirm Installation Selections page of the wizard, click Install.

7. After the installation is completed, the Installation Results page opens. Click Close.
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WINDOWS SERVER 2008 R2

The following steps show you how to install IIS and ASP.NET for Windows Server 2008 R2.

INSTALLING IIS

1. From the Start menu open the Server Manager dialog.

2. Click Add roles. The Add Roles Wizard opens.

3. Click Next.

4. Click the check box next to Web Server (IIS).

5. In the dialog that opens click Add Required Features.

6. In the Add Roles Wizard click Next.

7. Click Next again.

8. On the "Select Role Services" page of the wizard, expand Management Tools > IIS 6 Man-
agement Compatibility and click IIS 6 Metabase Compatibility.

9. On the Confirm Installation Selections page of the wizard, click Install.

10. After the installation is completed, click Finish.

INSTALLING ASP.NET

1. In the Server Manager dialog, expand Roles.

2. Select Web Server IIS.

3. In the Role Services section, click Add Role Services.

4. Click the check box next to ASP.NET to add a check mark.

5. Click Next.

6. Click Install.

7. Click Close.

8. In the search field enter run.

9. Click Run.The Run dialog opens.
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10. In the Open field, copy and paste one of the following into the field, depending on whether you
have a 32-bit or 64-bit system:

32-BIT

C:\WINDOWS\Microsoft.NET\Framework\v4.0.30319\aspnet_regiis -i

64-BIT

C:\WINDOWS\Microsoft.NET\Framework64\v4.0.30319\aspnet_regiis -i

11. Click OK.

A window opens, displaying the installation progress of ASP.NET. The window will close auto-
matically when the installation finishes.
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WINDOWS SERVER 2008

The following steps show you how to install IIS and ASP.NET for Windows Server 2008.

INSTALLING IIS

1. From the Start menu open the Server Manager dialog.

2. Click Add roles. The Add Roles Wizard opens.

3. Click Next.

4. Click the check box next to Web Server (IIS).

5. In the dialog that opens click Add Required Features.

6. In the Add Roles Wizard click Next.

7. Click Next again.

8. On the "Select Role Services" page of the wizard, expand Management Tools > IIS 6 Man-
agement Compatibility and click IIS 6 Metabase Compatibility.

9. On the Confirm Installation Selections page of the wizard, click Install.

10. After the installation is completed, click Finish.

INSTALLING ASP.NET

1. In the Server Manager dialog, expand Roles.

2. Select Web Server IIS.

3. In the Role Services section, click Add Role Services.

4. Click the check box next to ASP.NET to add a check mark.

5. Click Next.

6. Click Install.

7. Click Close.
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WINDOWS SERVER 2003

The following steps show you how to install IIS and ASP.NET for Windows Server 2003.

INSTALLING IIS VIA THE MANAGE YOUR SERVER DIALOG

1. From the Start menu open the Manage Your Server dialog.

2. Click Add or remove a role.The Configure Your Server Wizard opens.

3. Click Next.

4. Select Application server (IIS, ASP.NET) and click Next.

5. Click Enable ASP.NET and click Next.Your selections are summarized.

6. Click Next.The Windows Components Wizard opens, displaying the status of the installation.

7. After the installation is completed, click Finish.

INSTALLING IIS VIA THE CONTROL PANEL

1. Open the Control Panel. On many computers, you can do this by clicking Start > Control Panel.

2. Double-click Add or Remove Programs.The Add or Remove Programs window opens.

3. Click Add/Remove Windows Components.The Windows Components Wizard opens.

4. In the list of components select Application Server and then click Details.The Application
Server Dialog opens.

5. Click the check box next to Internet Information Services (IIS) to add a check mark.

6. In the Windows Component Wizard, "Application Server" should now be selected. Click Next.

7. Click Finish.
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INSTALLING ASP.NET

1. Click Start > Run.The Run dialog opens.

2. In the Open field, copy and paste one of the following into the field, depending on whether you
have a 32-bit or 64-bit system:

32-BIT

C:\WINDOWS\Microsoft.NET\Framework\v4.0.30319\aspnet_regiis -i

64-BIT

C:\WINDOWS\Microsoft.NET\Framework64\v4.0.30319\aspnet_regiis -i

3. Click OK.

A window opens, displaying the installation progress of ASP.NET. The window will close auto-
matically when the installation finishes.

NOTE: ASP.NET pages by default are prohibited in IIS. Therefore, you must set these
pages to be allowed if you are running Windows Server 2003. To do this: (1) In Inter-
net Information Services (IIS) Manager, select Web Service Extensions from the left
pane; (2) in the right pane, make sure that ASP.NET v4.0.30319 is set to Allowed. If it
is not, select it and click the Allow button.
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Setting Up a WebHelp Plus Target
The following steps show you how to set up your WebHelp Plus target for server-based output.

HOW TO SET UP THE WEBHELP PLUS TARGET

1. In Flare, open the WebHelp Plus target.The Target Editor opens.

2. Select the Publishing tab.

3. In the Indexing Service Catalog Name field, type the catalog that you are using for the output.
In most cases, this will be Web, which is the default value. However, if you or someone in your
company (e.g., network administrator) creates a custom catalog, you need to enter that
name in the field.

What is a catalog? Microsoft Indexing Service stores all of its index information in catalogs. A
catalog comprises index information and stored properties for a particular group of file sys-
tem directories. If Internet Information Services (IIS) is installed, the Indexing Service also cre-
ates a web catalog, which contains an index of IIS, the default virtual server of the World Wide
Web.

NOTE: This step is necessary only for Windows Server 2003.

4. Click to save your work.

5. Generate the target.

6. Publish the output to any location on the web server. If you want to use the default location
that was created after you installed IIS, you can publish the output to C:\Inetpub\wwwroot. If
you do this, you can use the "Default Web Site" folder that you will encounter when performing
the next set of steps (i.e., configuring IIS on the production server).

If you are working on your local machine for testing purposes, you do not need to publish the
output. You can simply view your WebHelp Plus output. When you view WebHelp Plus output
on your local computer, Flare creates a special folder called "MCPreview" within your "C:\Inet-
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pub\wwwroot" folder, and it places a copy of your WebHelp Plus output files in it. This enables
you to test the advanced features of WebHelp Plus on your local machine.
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Configuring IIS on Production Server
The following steps show you how to configure IIS, depending on the operating system. These steps
are necessary only for the server where you will be publishing the final output. It is not necessary to
perform these steps on your local computer for testing WebHelp Plus output.

WINDOWS SERVER 2003

1. Open the Control Panel. On many computers, you can do this by clicking Start > Control Panel.

2. Double-click Administrative Tools.The Administrative Tools dialog opens.

3. Double-click Internet Information Services.The Internet Information Services dialog opens.

4. Find your output folder and right-click the Service subfolder. Then select Properties.The Ser-
vice Properties dialog opens.

5. Select the Virtual Directory tab.

6. Next to the Application name field, click the Create button.

NOTE: If this button has already been selected, it will display as "Remove" instead. In
this case, you do not need to click the button.

7. In the Execute Permissions drop-down, make sure Scripts only is selected. It should already
be selected by default.

8. Click OK.
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WINDOWS SERVER 2008 AND 2008 R2, WINDOWS 2012, WINDOWS 7, AND WINDOWS 8

1. Open the Control Panel.

2. Select System and Security.

3. Select Administrative Tools. The various operating systems have different ways to find this
option.

4. Open the Internet Information Services (IIS) Manager.

5. Expand the node with the computer name.

6. Expand the Sites folder.

7. Expand the website folder corresponding to the one that you published.

8. Find your output folder and right-click the Service subfolder. Then select Convert to Applic-
ation.

9. Make sure the the application pool is using the .NET 4 framework.

a. In the dialog click Select.

b. From the drop-down select an application pool that is using the .NET 4 framework.

c. Click OK.

10. Click OK.
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Starting Microsoft Indexing Service
The following steps show you how to start the Microsoft Indexing Service on machines that are run-
ning Windows Server 2003. This procedure is not necessary for the other operating systems.

1. Open the Control Panel. On many computers, you can do this by clicking Start > Control Panel.

2. Double-click Administrative Tools.The Administrative Tools dialog opens.

3. Double-click Computer Management.The Computer Management dialog opens.

4. Expand Services and Applications.

5. Right-click Indexing Service.

6. In the context menu, click Start. The Indexing Service is now started.
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Starting Microsoft Windows Search
The following steps show you how to start the Microsoft Windows Search on machines that are run-
ning Windows Server 2008. This procedure is not necessary for the other operating systems.

1. From the Start menu open the Server Manager dialog.

2. Click Add roles.The Add Roles Wizard opens.

3. Click Next.

4. Click the check box next to Files Services.

5. Click Next twice.

6. Click the check box next to Windows Search Service.

7. Click Next twice.

8. Click Install.

9. Click Close.
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Enabling WebHelp Plus Search
The following steps show you how to enable WebHelp Plus search. These steps must be done for
each catalog that you are using on the server (or on your local machine, if you are viewing WebHelp
Plus output on your computer for testing purposes).

1. Navigate to the output folder for the WebHelp PlusHTML5 target on the server or on your local
machine.

If you are enabling WebHelp PlusHTML5 on your local machine, you can quickly find the out-
put folder by doing the following.

a. Open the Project Organizer.

b. Double-click the Targets folder.

c. Right-click on the target and select Open Output Folder.

2. In the output folder, double-click the Service folder.

3. Double-click the folder labeled Console.ConfigureSearch.

4. Double-click ConfigureSearch.exe. A window appears very briefly and then disappears.

5. Create a folder called "AutoMergeCache" at the root of the site. Then you must set security
preferences on the AutoMergeCache folder so the application can create and update files.

a. Right-click on the root folder and choose Explore to open Windows Explorer.

b. Right-click on AutoMergeCache and choose Properties.

c. On the Security tab click the Edit button.

d. Click Add.

i. Type Everyone and click Check Names, making sure it gets underlined.

ii. Click OK.

e. Make sure Everyone is highlighted and check the option for Full Control.

f. Click Apply.

g. Click OK to exit the Permission dialog.

h. Click OK to exit the Properties dialog.
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Testing WebHelp Plus Search
The following steps are optional for testing WebHelp Plus search (for Microsoft Windows Search).

1. In IIS right-click on the directory where your WebHelp Plus project is published to and choose
Explore.

2. In the upper-right corner of the window you will see a Search input box. Perform a search for a
term that is commonly found in your project.

3. If you see results, your project is ready to go live.
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Including Non-XHTML Files in Search
Supported In:

When end users perform a search in your online output, you can ensure that non-XHTML files (e.g.
PDF, DOC, XLS) are included in that search. The files do not even need to be linked to any of the con-
tent in your Flare project. This feature is available if you publish WebHelp Plus output to a web
server running Microsoft Internet Information Services (IIS).

HOW TO INCLUDE NON-XHTML FILES IN SEARCH

1. Enable WebHelp Plus Output If you want to take advantage of the advanced server-side fea-
tures of WebHelp Plus (i.e., automatic runtime project merging, faster search, server-side
search, searching of non-XHTML files), you must enable WebHelp Plus output. This includes
performing the following tasks: (1) installing Microsoft Internet Information Services (IIS) and
ASP.NET, (2) setting up the WebHelp Plus target and generating/publishing, (3) configuring IIS
on the production server, (4) starting Microsoft Indexing Service or Microsoft Windows
Search (depending on the operating system), and (5) enabling WebHelp Plus search.  For
more information see the online Help.

2. Generate WebHelp Plus Output In Flare, generate a target using the WebHelp Plus output
format.

3. Publish WebHelp Plus Output to Server Publish the WebHelp Plus output to your Microsoft IIS
Web server.

4. (Optional) Add IFilter File types that are automatically supported for WebHelp Plus search
include: Microsoft Office files, HTML files, and TXT files. For other non-supported file types,
such as PDF documents, you can download and install a simple IFilter in order to include that
file type in the search. To find and download the IFilter for the file type that you want to
include, go to a website that provides these (such as http://www.ifilter.org) and follow the
instructions for downloading IFilters. You must install the appropriate IFilters on the server
where the output files will be published, and if you are testing WebHelp Plus output on your
computer, you need to install the IFilter(s) locally as well.
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5. Copy and Paste Non-XHTML Files to Appropriate Folder Copy all of the non-XHTML files that
you want to be included in the search. Then paste them in the appropriate subfolder of the
WebHelp Plus output that you published. By default, WebHelp Plus will find any files located in
the project output folder, as well as the "AutoSearch" subfolder. Therefore, you can paste your
extra non-XHTML files in the AutoSearch subfolder.

EXAMPLE

http://www.xyzincorporated.com/help systems/MyTargetName/AutoSearch.

However, if there are any other folders where you want either XHTML or non-
XHTML files to be stored (instead of, or in addition to, AutoSearch), you can per-
form some extra steps to allow this.

Let's say you also want searches in the Help system to provide results from files
in the folder C:\ExternalSearchFolder. Here are the steps to allow this:

1. This folder must be accessible by IIS. Therefore, create a virtual directory
in IIS for it. Following are steps for doing this.

a. Open the Control Panel. On many computers, you can do this by click-
ing Start > Control Panel.

b. Double-click Administrative Tools. The Administrative Tools dialog
opens.

c. Double-click Internet Information Services. The Internet Information
Services (IIS) Manager dialog opens.

d. Expand the Web Sites folder.

e. Right-click on the Default Web Site folder and select New > Virtual Dir-
ectory.

f. Click Next.

g. In the Alias field, enter a name for the subfolder (e.g., SearchFolder).

h. Click Next.

i. Click the Browse button, then find and select the folder holding the
content that you want to publish (e.g., C:\ExternalSearchFolder).

j. Click Next.
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k. Make sure a check mark is next to Read.

l. Click Next.

m. Click Finish.

2. Create an XML file called "SearchFolders.xml" and place it in the
"AutoSearch" folder in the WebHelp Plus output directory. The contents of
this file will specify any virtual directories that WebHelp Plus should search.
Following is what you would type in the SearchFolders.xml file. This
example specifies just one folder, but you can add references to as many
virtual directories as you need.

<?xml version="1.0" encoding="utf-8"?>
<SearchFolders>

<Url>/SearchFolder</Url>
</SearchFolders>

When users perform a search in your output, those non-XHTML files will also be
scanned and become accessible to the users.
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NOTE: If you are testing WebHelp Plus output on your local machine, you need to view the
output at least one time. When you view WebHelp Plus output on your local computer, Flare
creates a special folder called "MCPreview" within your "C:\Inetpub\wwwroot" folder, and it
places a copy of your WebHelp Plus output files in it. This enables you to test the advanced
features of WebHelp Plus on your local machine. When testing this search feature on your
computer, you need to place the non-XHTML files in the AutoSearch subfolder at this loc-
ation (as opposed to the output folder that was generated where your Flare project is loc-
ated).

NOTE: If you are testing WebHelp Plus output on your local machine, you may need to wait
a few minutes after viewing the output for the Indexing Service to fully scan your files.
Otherwise, you may not immediately see the effects of the scan (e.g., searches of non-
XHTML files, incorporation of merged output files) in the output. If you avoid performing
other tasks during this period, the scanning of the files will be completed more quickly.

NOTE: If you want to test WebHelp Plus on your local computer, the advanced search fea-
tures of WebHelp Plus are not operable.

NOTE: The information just provided revolves around WebHelp Plus output. However, you
can also perform these same steps for HTML5 output if you have enabled the server-based
option. For more information see the online Help.
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CHAPTER 10

Searching the Outputs
Depending on the output type of your target, there are different search features available.

This chapter discusses the following:

Search Methods and Syntax 126

Searching a DotNet Help System 141

Searching a Microsoft HTML Help System 146

Searching an HTML5 System 155

Searching a WebHelp System 160

Searching a WebHelp Mobile System 164

Searching for Community Results 166

NOTE: End user search features are supported by the Eclipse Help Viewer and search oper-
ations are provided by a plug-in that you develop using the Eclipse platform (for more inform-
ation, see help.eclipse.org). The Flare search engine does not handle Eclipse Help search
operations.
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Search Methods and Syntax
When entering a search query, each output type supports different search methods and syntax.

Full-Text Search
All online output types support full-text search.

For Eclipse Help targets, search is provided by the Eclipse platform. For server-based output, search
is provided by the either the Microsoft Indexing Service or Windows Search.

For all other output types, Flare scans all of the target content and creates a database index for
search. When a user enters a search query, the search engine in the index to retrieve a list of topics
with matches. In Flare, search results include these matches:

n Case-insensitive Matches Search is not case-sensitive. For example, a search for the word
"run" will find matches for "Run" and "run."

n Matches with Variant Endings For example, a search for the word "run" will also find matches
for words such as, "runner," "running," and "runs." Since matches are not case-sensitive, the
results will include topics containing matches such as, "Runner," "Running," and "Runs."
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HOW TO PERFORM A FULL TEXT SEARCH

1. Open the online output.

2. In the search field, type a partial word or number string.

For example, type ham.

3. Press Enter or click Search.

NOTE: Search highlighting reveals the matches in the topic. In supported output types, you
can change the highlighting color for search hits. See "Search Highlighting and Styles" on
page 70.
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Phrase Search
All online output types support phrase search.

For Eclipse Help targets, search is provided by the Eclipse platform. For server-based outputs,
search is provided by the either the Microsoft Indexing Service or Windows Search.

End users can search for phrases by enclosing their search terms in quotation marks. This is useful
when end users want to restrict a search to locate terms that appear in an exact order. For
example, you might want to search for a phrase such as "Dog Friendly."

HOW TO PERFORM A PHRASE SEARCH

1. Open the online output.

2. In the search field, type a word, number, or character string.

3. Press Enter or click the Search button.

4. Double-click a match in the list to open the corresponding topic.

IMPORTANT: If you have enabled the stop words feature, search will not find
matches for queries containing stop words in quotes. For example, if you search for
the phrase "Pets are fun," search will only include topics with the words "pets" and
"fun." This is because the word "are" is part of the stop word list. See "Including Stop
Words in Search" on page 36.

NOTE: Search highlighting reveals the matches in the topic. In supported output
types, you can change the highlighting color for search hits. See "Search Highlighting
and Styles" on page 70.
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EXAMPLE

Let's say you search for the phrase "Dog Friendly". When you open the highest
ranking topic, search highlighting reveals both "Dog Friendly" and "dog friendly" as a
match.
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In a lower ranking topic, notice the topic contains two similar matches (i.e., a hyphen-
ated form of "dog-friendly" is found in the topic). Also observe that when matches are
not exact, there is no search highlighting.
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Boolean Operators
The DotNet Help, Microsoft HTML Help, WebHelp, and HTML5 output types support boolean oper-
ators —e.g., AND, OR, NEAR, NOT, and ( ). Note that when providing users with server-based
WebHelp or HTML5 output, boolean operators are not supported. Operators can be used in com-
bination with search terms to increase or decrease the number of search results.

REQUIREMENTS AND DEPENDENCIES

n DotNet Help Boolean search is supported when SQL Server Compact is installed on the com-
puter building the Flare output .

n Eclipse Help Boolean search is supported by the search engine that you configure in the
Eclipse platform. See the Eclipse documentation at help.eclipse.org.

n HTML Help Boolean search is provided by the viewer in accordance with the Microsoft Com-
piled HTML (CHM) specification. You must select the supported boolean operator from a pre-
defined drop-down list. See "Searching a Microsoft HTML Help System" on page 146.

n HTML5 Boolean search is provided by Flare in client-based output only. When delivering
server-based output, the Microsoft Indexing Service or Windows Search handles search. See
the Microsoft documentation for information about the Indexing Service (http://msdn.-
microsoft.com/en-us/library/ee805985(v=vs.85).aspx) or Windows Search (http://msdn.-
microsoft.com/en-us/library/windows/desktop/ff628790(v=vs.85).aspx). See also "HTML5
Server-based Output" on page 80.

n WebHelp and WebHelp Plus Boolean search is provided by Flare in client-based output only.
When delivering server-based output (WebHelp Plus), the Microsoft Indexing Service or
Windows Search service handles search. See the Microsoft documentation for information
about the Indexing Service (http://msdn.microsoft.com/en-us/library/ee805985
(v=vs.85).aspx) or Windows Search (http://msdn.microsoft.com/en-us/lib-
rary/windows/desktop/ff628790(v=vs.85).aspx). See also "WebHelp Plus Server-based Out-
put" on page 102.

HOW TO SEARCH WITH BOOLEAN OPERATORS

In the table below, a check mark shows the operators supported by each client-based output type. It
also details any supported variables and provides usage examples:
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Operators Usage

AND Use to narrow the
search and
retrieve only the
topics that con-
tain all of the
words it sep-
arates.

Type AND
between two or
more terms. This
is not case sens-
itive.

When separating
terms with a
blank space, the
AND is always
inferred. This is
only available in
HTML5 help.

Instead of the
word AND, type
the plus symbol
(+).

Instead of the
word AND, type
the ampersand
symbol (&).
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Operators Usage

OR Use to search for
two or more
words. This
broadens the
search results by
retrieving topics
that contain any
of the words it
separates.

Type or between
two or more
terms. This oper-
ator is not case
sensitive. 

When separating
terms with a
blank space, the
OR is always
inferred. This is
not available in
HTML5 help.

Type the pipe
symbol (|) instead
of typing OR.
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Operators Usage

NEAR Select from the
operator list to
find topics that
contain matches
that are in close
proximity to each
other.

This is only avail-
able in Microsoft
HTML Help. The
operator must be
selected from a
list.

CHAPTER 10  134



Operators Usage

NOT Use to search
only for matching
topics that do not
contain the term
following the oper-
ator.

Type NOT before
a term. This oper-
ator is not case-
sensitive.

Type the exclam-
ation mark (!)
instead of the
word NOT.

Use to find topics
that contain one
term but not the
other.

Type a term, fol-
lowed by the
carat symbol (^),
and then type
another term.
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Operators Usage

( ) Use
parentheses to
combine boolean
phrases and
search terms.

Type parentheses
( ) around the
combined terms.

1Only works if you search for one term but not another (e.g., MadCap NOT Flare).

2The carat symbol (^) can be used interchangeably with an exclamation point (!) and NOT.
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Asterisk (*) Wildcard Search
In the DotNet Help, Microsoft HTML Help, and WebHelp output types, end users can use the asterisk
(*) wildcard character with the search feature as detailed below:

REQUIREMENTS AND DEPENDENCIES

n DotNet Help Asterisk (*) wildcard search is supported when SQL Server Compact is installed
on the local computer building the Help .

n Eclipse Help Asterisk (*) wildcard search is supported by the search engine that you configure
in the Eclipse platform. For details, see the Eclipse documentation at:

help.eclipse.org

n WebHelp For asterisk (*) wildcard search capabilities to be supported, you must enable the
partial-word search feature. See "Enabling Partial-Word Search" on page 32.

HOW TO SEARCH WITH THE ASTERISK (*) WILDCARD

In the table below, a check mark shows the different ways you can use the asterisk (*) wildcard in
search. It also provides usage guidelines and examples. (DotNet Help requires SQL Compact).

Placement Usage

Before a
Term

Place the asterisk (*) in front of
a term to represent unknown
characters.

Inside a Term Place the asterisk (*) inside a
term to represent unknown
characters.

After a Term Place the asterisk (*) after a
term to represent unknown
characters.

1In Microsoft HTML Help, the asterisk (*) wildcard cannot be used in combination with other characters and
symbols. For example, instead of searching for *.doc, end users must search for *doc.
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Partial-Word Search
The DotNet Help, HTML5, WebHelp, WebHelp AIR, WebHelp Mobile, and WebHelp Plus output types
support partial-word searches in their target outputs. This search method is similar to simple text
search, only it allows users to search for partial-word and number strings. This feature can be
enabled in the Performance tab of the Target Editor. See "Enabling Partial-Word Search" on page
32.

For Eclipse Help, partial-search is provided by the Eclipse platform.

HOW TO PERFORM A PARTIAL-WORD SEARCH

1. In the search field, type part of a word or number string.

For example, type cond.

NOTE: The minimum number of characters that you can set for partial searches is 3.
See "Enabling Partial-Word Search" on page 32.

2. Press Enter or click Search.

The system reveals a list of ranked topics that include matches for the entered search string.

3. Double-click a topic in the list to open it.

NOTE: Search highlighting reveals the matches in the topic. In supported output
types, you can change the highlighting color for search hits. See "Search Highlighting
and Styles" on page 70.
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EXAMPLES

Search for cond.

As shown below, search retrieves topics containing the string "cond," such as "con-
dition" and "second."
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Search for 201.

As shown below, the search retrieves topics containing the number string "201," such
as 2010, 2011, 2012, 2013, 2014, 2015, 0.201, and 0.0201.
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Searching a DotNet Help System
End users have a variety of options when searching a DotNet Help system.

Search Experience
The user interface for the DotNet Help system is provided by a proprietary viewer (i.e., the Help
Viewer) which is designed specifically for use with Windows .NET applications. When an end user
searches a DotNet Help system for information, the results show both the topic rank and title.
Search highlighting also lets users quickly pinpoint the matches in topics. The example below shows
you the DotNet Help output:
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Features and Capabilities
This table details the search features and capabilities of the DotNet Help system. It also describes
the options that you have for customizing the user interface:

Feature Description Content Developer Options

Search Pane An accordion-style window pane that
reveals the search features.

Cannot be turned on and off.

Search Field and
Button

Type a search query. Then click the
button or press Enter to initiate a
search.

NOTE: Asterisk (*) wildcard
and boolean search cap-
abilities are available. See
"Search Methods and Syntax"
on page 126.

Cannot be turned on and off.

Filter List Provides users with the ability to nar-
row the scope of their search results
to categories defined by a search filter
set.

Cannot be turned on and off.

Customize the order of the search
filters in the output. See "Cus-
tomizing Search Filter Ordering" on
page 51.

Define the highlight color in the pro-
ject's stylesheet. See
"Search Highlighting and Styles" on
page 70.

Add to Favorites
Button

A button that lets users add the cur-
rent search query to a Favorites list.

Cannot be turned on and off.

Favorites Pane An accordion-style window pane that
reveals the end user's favorite topics
and searches.

Cannot be turned on and off.
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Feature Description Content Developer Options

Search Results Lists search results in ranked order. Cannot be turned on and off.

Optimize topics to improve search
results. See "Optimizing Search"
on page 168.

Search Highlighting Highlights matching keywords in top-
ics.

NOTE: Matches are not high-
lighted when users perform
searches with the asterisk (*)
wildcard character.

Cannot be turned on and off.

Define the highlight color in the pro-
ject's stylesheet. See
"Search Highlighting and Styles" on
page 70.

Quick Search Field Limits the scope of the search to the
active topic.

Cannot be turned on and off.

Select Search But-
ton

Opens the Search pane. Cannot be turned on and off.

Remove High-
lighting Button

Removes search highlighting from top-
ics.

Cannot be turned on and off.
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HOW TO SEARCH

1. Open the DotNet Help system.

2. In the navigation pane, click the Search pane.

3. In the search field, type your query. Then click Search or press Enter.

NOTE: Searches are not case-sensitive. See "Search Methods and Syntax" on page
126.

NOTE: The search query can include boolean operators or the asterisk (*) wildcard
character. See "Search Methods and Syntax" on page 126.

NOTE: If a search filter set is added to the project, users can narrow the scope of the
search by selecting an item from the Filter list. This limits the scope to search only
the topics assigned to the selected filter. See "Search Filter Set Example" on page 55.

4. In the search results list, double-click one of the topics to open it. Search highlighting reveals
the matches in the topic.
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NOTE: The search highlighting colors can be customized by the content developer.
See "Customizing Highlighted Search Terms" on page 72.

NOTE: If you want to remove the highlighting from the active topic, click the Remove
all search highlighting button in the Topic toolbar.
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Searching a Microsoft HTML Help System
End users have a variety of options when performing a search in a Microsoft HTML Help system.

Search Experience
A Standard skin provides the user interface for a Microsoft HTML Help system. It also includes fea-
tures defined by the Compiled HTML (CHM) specification.

When an end user searches a Microsoft HTML Help system for information, it reveals a list of topics
containing the matching term or phrase. The search results shows matches by title, location, and
rank. When an end user clicks a topic to open it, the matching terms are highlighted in the topic.
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Features and Capabilities
This table details the search features and capabilities of the Microsoft HTML Help system. It also
describes the options that you have for customizing the user interface:

Feature Description Content Developer Options…

Search Tab A tab that reveals the search
feature.

Enable the search feature using the Skin
Editor. See "Enabling Search in Skins" on
page 22.

Search Field and
Button

Type a search query. Then
click the button or press Enter
to initiate a search.

NOTE: Asterisk
(*) wildcard and
boolean search cap-
abilities are available.
See "Search Methods
and Syntax" on page
126.

Cannot be turned on and off.

Boolean Operators
List

A drop-down list of boolean
operators that can be used
with search.

Cannot be turned on and off.

Supports the listed boolean operators
only. See "Search Methods and Syntax" on
page 126.

Advanced Search
Check Boxes

A series of three advanced
search check boxes:

n Search previous results

n Match similar words

n Search titles only

Enable or disable these options in the Skin
Editor by clicking the HTML Help Setup
tab. Under MiscOptions, place a check
mark in theShow Advanced Search box.

Search Results Lists search results in ranked
order.

Cannot be turned on and off.

Optimize topics to improve search results.
See "Optimizing Search" on page 168.
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Feature Description Content Developer Options…

Display Button Opens the highlighted topic.
End users can alternatively
double-click a topic to open it.

Cannot be turned on and off.

Search Highlighting Highlights matching keywords
in topics.

Cannot modify search highlight color.

HOW TO SEARCH

1. Open the Microsoft HTML Help system.

2. In the navigation pane, click the Search tab.

3. Type the search query. Then click List Topics or press Enter.

NOTE: Searches are not case-sensitive. See "Search Methods and Syntax" on page
126.

NOTE: The search query can include boolean operators or the asterisk (*) wildcard
character. See "Search Methods and Syntax" on page 126.

HOW TO USE THE ADVANCED SEARCH OPTIONS

If you enabled the Advanced Search check boxes, users have option to refine the search
query as follows:

n Search Previous Results If you want to search only the topics included in the previous res-
ults list, place a check mark in theSearch previous results box.

n Match Similar Words To find words with similar spelling, place a check mark in theMatch
similar wordsbox. For example, if you type puppy and select this check box, the search
finds "puppy" and "puppies."

n Search Titles Only To search topics only for matches in the topic title, place a check
mark in theSearch titles only box.
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4. In the search results, open the desired topic using one of these methods:

a. Highlight a topic in the list. Then click Display.

OR

b. Double-click a topic in the list. Search highlighting reveals the matches in the topic.

NOTE: If you want to remove the highlighting from the active topic, click the Remove
all search highlighting button in the Topic toolbar.

NOTE: Unlike other output types, you cannot modify the search highlighting color in
Microsoft HTML Help. See "Search Highlighting and Styles" on page 70.
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Troubleshooting the No Topics Found Issue
A common issue encountered by Microsoft HTML Help developers is when a "No Topics Found" mes-
sage appears while searching a CHM file.

Typically, this is the result of an unregistered dynamic link library (DLL) file on the computer building
the Help file. The DLL is named "itcc.dll" and is a component of Microsoft's CHM specification. Its
purpose is to supply the operating system running Flare with the ability to build a CHM file with index
and search capabilities.

A variety of software vendors (particularly those that develop Help authoring tools) distribute a copy
of the itcc.dll file along with their program installation files. Should you happen to install or uninstall
program with a copy of this file (e.g., a Help tool or software program from another vendor or
another MadCap software tool that requires this file), it is possible for other copies of the itcc.dll file
to become unregistered.

To resolve this issue, the Flare \bin directory contains a batch file named RegisterItcc.bat. You can
run this batch file to re-register the DLL in Windows.

NOTE: Users running Windows 7 may need to switch off the computer's User Account Con-
trol (UAC) settings before beginning. For instructions, visit this link:

http://windows.microsoft.com/en-us/windows7/products/features/user-account-control

HOW TO REGISTER THE DLL USING THE BATCH FILE

1. In Windows Explorer, navigate to the Flare installation's \bin directory. Typically, the path is as
follows (where [#]= the Flare version number):

n Windows 7 or 8 (64-bit versions)

l If you are using Flare 12 or later C:\Program Files\MadCap Soft-
ware\MadCap Flare [#]\Flare.app\Resources\Bin

l If you are using Flare 11 or earlier C:\Program Files\MadCap Soft-
ware\MadCap Flare V[#]\Flare.app\Resources\Bin

n Windows 7 or 8 (32-bit versions) C:\Program Files (x86)\MadCap Soft-
ware\MadCap Flare V[#]\Flare.app\Resources\Bin
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NOTE: The path that you use depends on your specific system configuration. For
users running the 64-bit version of Windows, you will see two folders named
Program Files on your C: drive. Typically, the folder named "\Program Files (x86)"
stores non-native 32-bit applications, and the "\Program Files" folder stores nat-
ive 64-bit applications, such as Flare. If you installed Flare in a different location,
you need to determine the appropriate path to the \bin directory.

2. In the bin directory, double-click the file named RegisterItcc.bat.

This runs the batch file. If the registration is successful, a message appears telling you so.

NOTE: If the following error message appears, the account you are using may not
have sufficient permissions to run the batch file on the computer.

You will need to use your computer's command line utility to register the DLL as
described below or contact your Windows administrator for assistance with regis-
tering the DLL.
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HOW TO REGISTER THE DLL USING THE COMMAND LINE UTILITY

1. In Windows Explorer, open the computer's System32 directory. The path is C:\Win-
dows\System32.

2. Right-click the application file named cmd.exe and select Run as administrator from the con-
text menu.

3. If the User Account Control message appears, click Yes. This allows you to use the command
prompt to make changes on the system.

NOTE: In Windows 7, you can use this method to run the command prompt as an
administrator when you are using an account that does not have administrative cre-
dentials. This typically allows most users to make changes to the itcc.dll file in the
Flare \bin directory.
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4. At the command prompt, do the following:

a. Type cd to change directories and press the SPACEBAR. Then type the path to the Flare
\bin directory as shown in this example:

EXAMPLE

Use this information to enter the following path, depending on the version of
Flare you are using.

IF YOU ARE USING FLARE 12 OR LATER

C:\Program Files\MadCap Software\MadCap Flare
[#]\Flare.app\Resources\Bin

Below is an example:

C:\Program Files\MadCap Software\MadCap Flare
12\Flare.app\Resources\Bin

IF YOU ARE USING FLARE 11 OR EARLIER

C:\Program Files (x86)\MadCap Software\MadCap Flare V
[#]\Flare.app\Resources\Bin

Where [#] appears above, you must enter the correct Flare version number
when typing the system path (e.g., V8, V9, V10.). Below is an example:

C:\Program Files (x86)\MadCap Software\MadCap Flare
V11\Flare.app\Resources\Bin
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b. Press Enter.

5. At the command prompt, type: registeritcc.bat. Then press Enter. This runs the batch
file. If the registration is successful, a message tells you so.

6. Click OK to acknowledge the message.

7. Close the command prompt.

After registering the DLL, build your Microsoft HTML Help output again. Then retry your search in
the output.
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Searching an HTML5 System
End users have a variety of options when performing a search in a HTML5 system.

Search Experience
An HTML5 skin provides the user interface for an HTML5 system. When an end user searches an
HTML5 system for information, it reveals a list of topics containing the matching term or phrase.
The search results show the topic title and the topics are listed in ranked order. The results also
include an excerpt of the paragraph text from the topic (or you can opt to use the meta description
that you add to the topic properties). This helps users decide if the page contains the information
they were looking for. When a user clicks a topic to open it, the matching terms are highlighted in
the topic.
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Features and Capabilities
This table details the search features and capabilities of the HTML5 system. It also describes the
options that you have for customizing the user interface:

Feature Description Content Developer Options

Search Field
and Button

Type a search query. Then click the
button or press Enter to initiate a
search.

NOTE: Asterisk (*) wildcard
and boolean search cap-
abilities are available. See
"Search Methods and Syn-
tax" on page 126.

Change the look of the field and button.

Filters List Provides users with the ability to
narrow the scope of their search
results to categories defined by a
search filter set.

Create filter selections by adding a search
filter set and associating it with the Flare
target. See "Creating Search Filters" on
page 49 and "Associating a Search Filter
Set with a Target" on page 52.

Customize the order of the search filters
in the output. See "Customizing Search Fil-
ter Ordering" on page 51.

Change the appearance of the drop-down
in the Skin Editor.
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Feature Description Content Developer Options

Search Results Lists search results in ranked order.

Matching keywords are bolded in
search results.

NOTE: If you are using
Pulse, your search results
list may include community
results. See "Searching for
Community Results" on
page 166.

Change the appearance of your search
results.

Set the number of search results that dis-
play on each page. See "Optimizing Your
Site" on page 262.

Adjust the weight the search engine
places on internal links to a topic when
ranking search results. See "Setting
Search Result Importance" on page 228.

If you are using Pulse, you have the option
to display community results in search. 

Search High-
lighting

Highlights matching keywords in
topics.

Tripane output shows highlights
words in color by default. In Side
and Top Navigation outputs, search
results are transparent, but you can
customize this, adding colors.

NOTE: Matches are not
highlighted when users per-
form searches with the
asterisk (*) wildcard char-
acter.

Define the highlight color in the project's
stylesheet. See "Search Highlighting and
Styles" on page 70.

Remove High-
lighting Button

Removes search highlighting from
topics.

Include this button in the toolbar.

Search Result
Pagination
Options

Change the number of search res-
ults that appear on the page.

Include and format pagination options.
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Feature Description Content Developer Options

Search Non-
HTML Files

(Server-based
Output Only)

When end users perform a search
in your online output, you can
ensure that non-XHTML files (e.g.
PDF, DOC, XLS) are included in that
search.

Include non-HTML files in search results
when publishing server-based output. See
"Including Non-XHTML Files in HTML5
Search" on page 98.

HOW TO SEARCH

1. Open the HTML5 system.

2. In the search field, type the search query. Then click the Search button or press Enter.

NOTE: Searches are not case-sensitive. See "Search Methods and Syntax" on page
126.

NOTE: If a search filter set is added to the project, users can narrow the scope of the
search by selecting an item from the Filter list. This limits the scope to search only
the topics assigned to the selected filter. See "Search Filter Set Example" on page 55.

3. In the search results list, double-click one of the topics to open it. Search highlighting reveals
the matches in the topic.

NOTE: The search highlighting colors can be customized by the content developer.
See "Customizing Highlighted Search Terms" on page 72.

NOTE: If you want to remove the highlighting from the active topic, click the Remove
all search highlighting button in the Topic toolbar.
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Searching a WebHelp System
Supported In:

End users have a variety of options for searching a WebHelp, WebHelp AIR, or WebHelp Plus system.
To learn about the HTML5 system, see "Searching an HTML5 System" on page 155.

Search Experience
A Standard skin provides the user interface for a published WebHelp system. When an end user
searches a WebHelp system for information, the results show the topic rank and title. When the
user opens a topic, search highlighting reveals the matches.
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Features and Capabilities
This table details the search features and capabilities of the WebHelp system. It also describes the
options that you have for customizing the user interface:

Feature Description Content Developer Options

Search Pane An accordion-style window pane that
reveals the search features.

Enable the search feature using the Skin
Editor. See "Enabling Search in Skins" on
page 22.

Search Field
and Button

Type a search query. Then click the
button or press Enter to initiate a
search.

NOTE: Asterisk (*) wildcard
and boolean search cap-
abilities are available. See
"Search Methods and Syn-
tax" on page 126.

Change the tooltip and button. .

Filter List Provides users with the ability to nar-
row the scope of their search results
to categories defined by a search fil-
ter set.

Create filter selections by adding a
search filter set and associating it with
the Flare target. See "Creating Search Fil-
ters" on page 49 and "Associating a
Search Filter Set with a Target" on page
52.

Customize the order of the search filters
in the output. See "Customizing Search
Filter Ordering" on page 51.

Add to Favor-
ites Button

A button that lets users add the cur-
rent search query to a Favorites list.

Enable the Favorites feature to give
users the ability to save search strings to
the favorites list.

Favorites Pane An accordion-style window pane that
reveals the end user's favorite topics
and searches.

Enable the Favorites feature to give
users the ability to save search strings to
the favorites list.
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Feature Description Content Developer Options

Search Results Lists search results in ranked order.

NOTE: If you are using
Pulse, your search results
list may include community
results. See "Searching for
Community Results" on page
166.

If you are using Pulse, you have the
option to display community results in
search. 

Search High-
lighting

Highlights matching keywords in top-
ics.

NOTE: Matches are not high-
lighted when users perform
searches with the asterisk
(*) wildcard character.

Define the colors used for search high-
lighting. See "Search Highlighting and
Styles" on page 70.

Quick
Search Field
and Button

Users can search for matches in the
active topic by entering terms in the
field.

Asterisk (*) wildcard and boolean
search is not supported.

Enable this field in the toolbar.

Remove High-
lighting Button

Users can remove any search high-
lighting.

Include this button in the toolbar.

Search Non-
HTML Files
and Faster
Search

(WebHelp Plus
Only)

When end users perform a search in
your online output, you can ensure
that non-XHTML files (e.g. PDF,
DOC, XLS) are included in that
search. Search performance is also
faster.

Include non-HTML files in search results
and enjoy faster search performance
when publishing server-based output.
See "Including Non-XHTML Files in
Search" on page 121.
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HOW TO SEARCH

1. Open the WebHelp, WebHelp AIR, or WebHelp Plus system.

2. In the navigation pane, click Search.

3. In the entry field, type the search query. Then press Enter or click Search.

NOTE: Searches are not case-sensitive. See "Search Methods and Syntax" on page
126.

NOTE: The search query can include boolean operators or the asterisk (*) wildcard
character. See "Search Methods and Syntax" on page 126.

NOTE: If a search filter set is added to the project, users can narrow the scope of the
search by selecting an item from the Filter list. This limits the scope to search only
the topics assigned to the selected filter. See "Search Filter Set Example" on page 55.

4. In the search results list, double-click one of the topics in the search list to open it. Search
highlighting reveals the matches in the topic.

NOTE: The search highlighting colors can be customized by the content developer.
See "Customizing Highlighted Search Terms" on page 72.
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Searching a WebHelp Mobile System
End users have a variety of options when performing a search in a WebHelp Mobile system.

Search Experience
A WebHelp Mobile skin provides the user interface for a published WebHelp Mobile system. When
an end user searches a WebHelp Mobile system for information, it reveals a list of topics containing
the matching term or phrase. These search results show the topic title results in ranked order.
When an end user clicks a topic to open it, search highlighting reveals the matches.

Features and Capabilities
This table details the search features and capabilities of the WebHelp Mobile system. It also
describes the options that you have for customizing the user interface:

Feature Description Content Developer Options…

Search Field
and Button

Type a search query. Then
tap the button to initiate a
search.

Enable the search feature using the Skin Editor.
See "Enabling Search in Skins" on page 22.

Change the appearance of the Search field and
button.

Search Results Lists search results in ranked
order.

Optimize topics to improve search results. See
"Optimizing Search" on page 168.

Search High-
lighting

Highlights matching
keywords in topics.

Define the highlight color in the project's
stylesheet. See "Search Highlighting and Styles"
on page 70.
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HOW TO SEARCH

1. Open a WebHelp Mobile system on a device.

2. In the search field, type a search query. Then tap Search.

NOTE: Searches are not case-sensitive. See "Search Methods and Syntax" on page
126.

3. In the search results, tap the desired topic to open it. Search highlighting reveals the matches
in the topic.

NOTE: If you are generating WebHelp Mobile output, please note that search is not sup-
ported in LG WebOS (Palm WebOS).
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Searching for Community Results
AVAILABLE TO: Administrators, Employees, and Customers

When integrating a Pulse system with a Flare community, you have two different search options.
You can search a feed in Pulse or, if you enable the feature, you can extend the scope of a Flare
search to include the Flare community results stored in Pulse.

Searching a Pulse Feed
In the Flare output, users can search a Pulse feed for matches. With this method of search, the
scope of the search is limited to the active topic feed.

HOW TO SEARCH A PULSE FEED

1. Log into the Flare output or Pulse dashboard using a registered Pulse account.

2. In the embedded discussion form, type a search query in the Search this Feed box.

3. Press Enter. This searches only the active feed.
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Searching the Flare Output for Community Results
If you enable the display of community search results in the Flare skin (i.e., select Display com-
munity search results), the scope of a Flare search can be extended to include matching com-
munity activity from Pulse.

HOW TO SEARCH THE FLARE OUTPUT FOR COMMUNITY RESULTS

1. Log into the Flare output using a registered Pulse account.

2. In the search entry field associated with the Flare output, type your search query and then
press Enter.

3. In the search results page, any posts containing your search terms appear under a heading
titled "Community Results." Any matching Pulse activity is listed beneath the heading.
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CHAPTER 11

Optimizing Search
There are several optimization tasks you can follow to improve the quality of your search results.

This chapter discusses the following:

Setting Up a Search Engine 169

Elasticsearch 174

Google Search 205

MadCap Search 218

Setting the Search Abstract Character Limit 222

Including Glossary Terms in Search Results 224

Setting Search Result Importance 228

Setting the Number of Search Results Per Page 232

Generating Sitemaps for SEO 234

Ranking Search Results 235

Optimizing Your Content 241

Meta Descriptions for Topics 260

Optimizing Your Site 262
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Setting Up a Search Engine
Supported In:

For HTML5 targets, you can choose the type of search engine you want people to use—MadCap
Search, Google Search, or Elasticsearch (for Side Navigation, Top Navigation, or skinless output).
There are additional steps that you can follow to set up each of these engines. For MadCap Search,
this includes setting the search result importance, including glossary terms in the results, setting
the number of results per page, and setting the abstract character limit. For Google Search, this
includes creating a new search engine, verifying the URL, adding a sitemap, submitting the site for
indexing, excluding the TOC from indexing, customizing the appearance of the results, and review-
ing the indexing status. For Elasticsearch, there are several search results and auto-complete res-
ults you can configure for your search engine.

See the online Help for more information about search engine type available for your output.
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Comparison of Search Engine Options
There are benefits to any of the search methods offered by Flare. Some users might prefer the
search results returned by Google. However, others might prefer the results returned by MadCap.
Or some users might want all of the configurable options provided by Elasticsearch.

TIP: To determine the type of search that is best for you, we recommend that you generate
different outputs using each method. Then perform several different searches and see
which results you like best.

Elasticsearch Google Search MadCap Search

Time and Effort
to Set Up

Setting up Elasticsearch
is done within the Target
Editor and Destination
Editor in Flare. Web serv-
ers also need to be con-
figured to support Flare,
along with the Elastic-
search service.

Setting up a Google cus-
tom search engine
(CSE) and performing
other necessary tasks
requires a combination
of steps in both Google
and Flare. This can take
a bit of time to com-
plete. However, it is usu-
ally just a one-time
setup.

Setting up MadCap
Search in a Flare project
takes only a few
seconds.

Public Versus
Local Output

Output must be pub-
lished on a server in
order to use the full cap-
ability of Elasticsearch.

Output must be available
publicly so that you can
use Google. Output can-
not be behind a firewall.

Output can be
searched whether it is
available publicly or loc-
ally.
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Elasticsearch Google Search MadCap Search

Number of Out-
puts

You can manage mul-
tiple HTML5 targets that
use Elasticsearch
through the Content Ser-
vices Portal.

You can add multiple
folders/sites to be
included in your Google
custom search engine
(CSE). Each of these
sites can be a separately
published Flare output.
When users search from
one of the published
Flare outputs, results will
display for all of the out-
puts.

Searches will include res-
ults for only the Flare out-
put that is open.

Other File
Types

Most file types are
included in the search
results.

If you have added
other types of files (e.g.,
PDF) to the site(s) asso-
ciated with your CSE,
they may be included in
search results.

In order to include file
types such as PDF in
your search results, you
need to generate and
publish server-based out-
put.

Search Tailored
to Flare Pro-
jects

Elasticsearch does not
provide any direct map-
ping of search criteria to
the structure of a Flare
project.

Google does not recog-
nize the unique char-
acteristics of a Flare
project (e.g., index
keywords, glossaries).
Therefore, those ele-
ments will have no
effect on how Google
ranks pages in the res-
ults.

MadCap Search rank-
ings are specifically
tailored for Flare users.
They take into account
not only H1-H6 headings,
but also index keywords,
glossary terms, etc. See
"Ranking Search Results"
on page 235.

Glossary Defin-
itions in Results

Elasticsearch does not
provide an option to
include glossary terms in
your search results.

Google will not fetch
your project’s glossary
terms and feature them
at the top of search res-
ults.

MadCap Search will
fetch your project’s gloss-
ary terms and feature
them at the top of
search results.
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Elasticsearch Google Search MadCap Search

Incorrectly
Typed
Searches

The partial-word
search and fuzzy match
settings allow for numer-
ous searches to be
returned when these set-
tings are enabled.

If an end user incor-
rectly enters a search
term (e.g., types “Tble”
instead of “Table”),
Google will often guess
the correct term and
show results anyway.

Incorrectly typed search
terms will not return res-
ults.

Search and
Indexing Speed

The administrator
portal allows for the
search indexes to be
managed closely. This
will assist in keeping
search result times
optimal.

Search results might lag
at times, depending on
the size of the output
and whether Google is
finished with the index-
ing (i.e., making your out-
put available for
searches).

Google will index your
pages automatically
over time, but it can take
awhile, sometimes
weeks.

Search results might
be faster because the
output is immediately
indexed once it is gen-
erated. You do not need
to spend any extra time
indexing your pages or
waiting for search results
to appear.

Mobile Devices Search results always
come from a server, so
you do not need to be
concerned about the abil-
ity of the mobile device
to handle the inform-
ation.

Search results always
come from a server, so
you do not need to be
concerned about the abil-
ity of the mobile device
to handle the inform-
ation.

Search results are
“chunked” and then col-
lapsed so that they can
be displayed when a
search is performed.
This is usually okay on
PCs, but if you try to per-
form a search on a
mobile device, the res-
ults might be slow or
even crash because the
device cannot handle the
number of search res-
ults.
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Elasticsearch Google Search MadCap Search

Advertisements No advertisements
are included in search
results.

Users might see advert-
isements in search res-
ults.

No advertisements
are included in search
results.

Auto-Complete
Results

You can enable mul-
tiple options to include a
mix of personal and
global searches on your
output. There is also an
option to include project
content information
such as topic titles and
the file path in your pro-
ject.

While Google Search
does provide auto-com-
plete results, it does not
provide the ability to cus-
tomize these results.

There are no options
available for auto-com-
plete results.

Predictive
Search

There are multiple
options that allow you to
obtain predictive results
when searching, espe-
cially when using auto-
complete options.

Google Search provides
a measure of predictive
results, although it is not
customizable within
Flare.

MadCap Search does
not offer any predictive
methods in obtaining
search results.

NOTE: Google Search is not supported for HTML5 Tripane output.

NOTE: For MadCap Search, the look of the search bar and results can be customized
through these skins and components: Top Navigation skin, Side Navigation skin, Search Bar
skin component, and Search Results skin component. However, with Google Search, any
changes in these skins are not supported. Instead, the look is controlled via Google.

NOTE: Keep in mind that the exact steps in Google may change over time as the user inter-
face is adjusted.
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Elasticsearch
Supported In:

Elasticsearch is a powerful search engine that provides numerous unique, configurable options,
including "fuzzy matching” (i.e., matching similar words), predictive search, and auto-completion.

Elasticsearch is enabled by two web services, one used by Flare and the other used by Elastic-
search. The Elasticsearch web service runs a portal that allows you to manage the targets, topics,
and indexes employed by the Elasticsearch engine in your server-based HTML5 target.
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GENERAL STEPS FOR USING ELASTICSEARCH

These are the steps needed to set up Elasticsearch.

1. Set Up Server Configure a remote server to store your search indexing data. This is usually
done by a network administrator. See"Installing Elasticsearch on a Remote Server" on page
181.

2. Set Search Engine Select Elasticsearch as the search engine in the Target Editor. See
"Enabling Elasticsearch Through the Target Editor" on page 190.

3. Create Destination Files Add and configure primary and Elasticsearch destination files so you
can publish your output and search results. See "Creating Publishing Destinations for Elastic-
search" on page 196.

4. Connect Destinations with Target Associate your publishing destinations with the HTML5 tar-
get. See "Associating Elasticsearch Destinations with a Target" on page 197.

5. Generate and Test Output Build the HTML5 target. When the build is near completion, you will
notice a new icon display in the system tray. This is for the MadCap Process Manager, which
will handle the web services required for Elasticsearch if you are running locally on your
machine. See "MadCap Process Manager" on page 198.

Once the build is complete, start testing your output with a few searches to ensure Elastic-
search is working in accordance with your configuration.

6. Manage Search Indexes As your Elasticsearch output is searched, you may want to control
the size of the indexes for your target. See "Content Services Portal" on page 199.

NOTE: You can also modify the appearance of your auto-complete suggestions in the
search results. See the Flare Skins Guide or the Flare online Help for more information.

NOTE: Search filters are not supported in Elasticsearch.
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EXAMPLE

Bob wants to use Elasticsearch with his HTML5 output.

First, he sends his network administrator the steps for setting up a Elasticsearch
remote server ("Installing Elasticsearch on a Remote Server" on page 181).

After the network administrator finishes setting up ther server, she sends Bob the URL
for it. In this case, let’s say the URL is https://ourelasticsearchservices.fictionsoft.com.

Bob opens his HTML5 target, selects the Search tab, and chooses Elasticsearch as the
search engine type.

He also decides which Elasticsearch options on that tab he wants to use and sets them
accordingly.

Next, Bob creates a primary publishing destination. This is the destination where he will
send his output.
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Let’s say Bob needs to upload his output to this location:

help.fictionsoft.com/myoutput/

One option is that Bob could use file transfer protocol (FTP) to copy his output directly
up to the server where his output will be hosted. But suppose Bob prefers to use a third-
party tool (say, FileZilla) to transfer his output files to the server. In that case, Bob
chooses File System as the type, and for the directory he selects a folder that he cre-
ated in his My Documents folder.
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Now Bob creates an Elasticsearch destination file. In this file, he chooses Elasticsearch
as the type, and he enters the URL that his network administrator gave him
(https://ourelasticsearchservices.fictionsoft.com).
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Next, Bob returns to his target and opens the Publishing tab. In this tab, he places a
check mark next to his primary destination. Then in the Elasticsearch Destination cell,
he chooses the other destination file.

After saving all his changes, Bob builds the target. When that is done, he clicks the Pub-
lish button in the Target Editor, which copies the output files to the local folder he set
up in his My Documents directory.

Finally, Bob uses his third-party tool to transfer the output files from that My Docu-
ments folder up to their final destination (help.fictionsoft.com/myoutput/). When users
access that output, the search function will be using Elasticsearch features.

NOTE: You must use Elasticsearch version 5.6, since that is the version supported by
MadCap Flare.
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NOTE: If you enable the Mark of the Web setting in your Elasticsearch target and viewing
the output locally in Internet Explorer, you will continuously receive the following warning
message:

This message will display every time you enter search criteria. In order to avoid receiving
this message, it is recommended that you disable the Mark of the Web setting. See the
Flare Targets Guide or the Flare online Help for more information.

NOTE: Synonyms are not supported in Elasticsearch.

NOTE: If you are viewing your generated Elasticsearch output on Microsoft Edge, you will
not be able to search. In order to use Edge for your Elasticsearch output, you will need to
run the following command prompt one time as an administrator:

n CheckNetIsolation LoopbackExempt -d -n=Microsoft.MicrosoftEdge_8weky-
b3d8bbwe

This will disable loopback in your Edge browser and allow you to use your Elasticsearch tar-
get in Edge. For more information on this, visit Enabling Elasticsearch Targets In Microsoft
Edge.

NOTE: Elasticsearch is not supported for outputs hosted through MadCap Central.

NOTE: Search filters are not supported in Elasticsearch.
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Installing Elasticsearch on a Remote Server

Information for Network Administrators

There are three sections to installing Elasticsearch on a remote server. These are steps usually com-
pleted by a network adminstrator.

1. Installing prerequisites on the remote server.

2. Installing the Elasticsearch service.

3. Configuring the Elasticsearch web application.

HOW TO INSTALL PREREQUISITES FOR THE REMOTE SERVER

1. Ensure that the following components are installed on your web server for .NET Framework
4.5 and IIS Web Server:

n .NET Framework 4.5 Features

l ASP.NET 4.5

n Web Server (IIS)

l Web Server

o Common HTTP Features

o Static Content

o Default Document

o Directory Browsing

o HTTP Errors

o Security

o Request Filtering

o Basic Authentication

o Windows Authentication
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o Application Development

o .NET Extensibility 4.5

o ISAPI Extensions

o ISAPI Filters

o ASP.NET 4.5

o Health and Diagnostics

o HTTP Logging

o Performance

o Static Content Compression

l Management Tools

o IIS Management Console

o IIS 6 Management Compatibility

o IIS 6 Metabase Compatibility

If any of these components are missing, install them on the server to ensure the Elasticsearch
service is installed and runs properly. They can be installed through Server Manager > Add
Roles and Features.

2. Create and configure your web server on Internet Information Services (IIS).

3. Download and install .NET Core 1.1.6 Windows Hosting Bundle Installer.

See https://www.microsoft.com/net/download/dotnet-core/runtime-1.1.6.

4. Reboot your web server.

5. Download and install the 64-bit Java SE Development Kit (JDK) version 8 to your remote
server.

See http://www.madcapsoftware.com/downloads/jdk.aspx.

6. When JDK 8 has been successfully installed, open the Environment Variables dialog on your
server.

7. Add a System Environment variable called “JAVA_HOME” that is pointing to the path where
JDK was installed (i.e., C:\Program Files\Java\jdk1.8.0_171\).

8. Reboot the web server after adding the environment variable.
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9. To verify that JDK 8 is working properly, open a command prompt window.

10. At the command prompt, type javac and press Enter. If you see javac options display below
the command prompt, JDK 8 is working properly.
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HOW TO INSTALL ELASTICSEARCH ON THE REMOTE SERVER

1. Navigate to the Elasticsearch folder at the location where you have Flare installed (e.g.,
C:\Program Files\MadCap Software\MadCap Flare 14\Flare.app\Resources\Elasticsearch).

2. Copy this Elasticsearch folder from your local machine to the remote server. This folder can
be copied anywhere on the remote server.

3. Right-click on the Elasticsearch folder on the remote server, and select Properties.

4. In the Groups or user names section, select the Everyone account. If this account is not listed,
create this account.

5. In the Permissions section, under the Allow category, enable the Read and Write permissions.

6. Click OK.

7. Open the elasticsearch.yml file in a text editor from the Elasticsearch\config directory you
just copied over to the remote server.

8. Under the Network section, find the string “http.port: 9200” and remove the # character from
it.

9. Save your changes in this file.

10. Open a command prompt window and navigate to the location of the copied Elastic-
search\bin directory.

11. Type elasticsearch-service.bat install and press Enter.
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12. Type elasticsearch-service.bat start and press Enter. Elasticsearch is now run-
ning on your remote server.

13. Copy the Web.ContentServices folder from your local machine where you have Flare installed
(e.g., C:\Program Files\MadCap Software\MadCap Flare 14\Flare.ap-
p\Resources\WebHelp2\ContentServices\Web.ContentServices).

14. Place this copy of the Web.ContentServices folder in the following location on the remote
server: C:/inetpub/wwwroot.

NOTE: The C:/inetpub/wwwroot/Web.ContentServices folder will be referenced to
configure the remaining steps in this section.

15. Right-click the Web.ContentServices folder on the remote server, and select Properties.

16. In the Groups or user names section, select the Everyone account. If this account is not listed,
create this account.

17. In the Permissions section, under the Allow category, enable the Read and Write permissions.

18. Click OK.

19. Within the Web.ContentServices folder on the remote server, create a folder titled “logs.”

20. Within the Web.ContentServices folder, open the appsettings.json file.
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21. Under ConnectionStrings, update the path to be used for the DefaultConnection The default
string is "C:\\inetpub\\wwwroot\\Web.ContentServices\\Indices.db."

NOTE: The Indices.db file is actually not created until the Content Services applic-
ation is started in IIS and users start searching on the Elasticsearch output. In this
step, you are simply specifying the location of where you want this file to reside on
your remote server.

NOTE: Elasticsearch uses port 9200 by default. If you wish to change the port num-
ber, you can specify the port number in the DefaultConnection string (e.g., http://-
localhost: 9601). However, the port number must also match the http.port field in the
elasticsearch.yml file.
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22. Under ContentServicesStartupConfigSettings, update the path to be used for the
DataRootDir. The default string is "C:\\inetpub\\wwwroot\\Web.ContentServices".

NOTE: Ensure that the paths you provide for DefaultConnection and DataRootDir in
the appsettings.json file have read/write permissions for the user account logging
into the web server.

WARNING: If you decide to place the Web.ContentServices folder in a different location
from the C:\inetpub\wwwroot location indicated in step 14, ensure that the configuration
settings in the appsettings.json file match the location on your remote server where you
placed the Web.ContentServices folder.
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HOW TO CONFIGURE THE CONTENT SERVICES WEB APPLICATION

1. Install the URL Rewrite Module. This is necessary to enable IP address security restrictions to
work in your web.config file.

See https://www.iis.net/downloads/microsoft/url-rewrite.

2. Within the Web.ContentServices folder, open the web.config file.

3. Remove the comment characters from the <rewrite> and </rewrite> tags in this file.

4. Modify YOUR_IP_ADDRESS with your desired IP address pattern . You can enter a range of
IP addresses in this field, or a singular IP address. This will block other addresses that do not
match your IP address pattern from gaining administrator access to your Content Services
Portal.

5. Open IIS Manager.

6. Right-click Application Pools, and select Add Application Pool.

7. In IIS Manager, navigate to Sites > Default Web Site.
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8. Right-click Default Web Site and select Add Application.

9. Enter the name of the Alias for your Elasticsearch website.

10. Click the Select button and choose your Application pool.

NOTE: You can use the default Application pool or create a new one for this service.

11. Next to the Physical path field, click the ellipsis button .

12. Select the C:\inetpub\wwwroot\Web.ContentServices directory. Or, if you placed the
Web.ContentServices directory in another location on your server, select that location
instead.

13. Click OK. Your Content Services application is now displayed under Default Web Site in IIS.

14. Click Start (or Restart if it is already running) on your Default Web Site. The Content Services
application is now running.
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Enabling Elasticsearch Through the Target Editor
Follow these steps to configure Elasticsearch for your server-based HTML5 target.

HOW TO ENABLE ELASTICSEARCH

1. Open the target.

2. Click the Search tab.

3. Click the drop-down in the Type field and select Elasticsearch.
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4. Configure the following options you need to enable Elasticsearch for your output.

Field Name Description

Search Results

Results Per
Page

You can change the number of search results that appear on each page.
This makes it easier for users to navigate between pages of search res-
ults and improves loading times, especially for users who access your out-
put from a mobile device. Setting a reasonable number of results per
page also makes it easier for search indexing services (i.e., spiders, crawl-
ers, or bots) to locate pages in your output, improving search results. You
can set between 1-100 search results per page.

Fragments Per
Result

This sets the number of fragments that contain the text of the searched
item shown in the preview text. The fragment level can be set anywhere
from 0-5. This applies to both search results and Autocompletion Types.
One example is if you typed in the word "Search" in the search bar. The
search result extract might display like this:

n "Search can be conducted from multiple locations. There are three
types of searches that can be selected in the Target Editor. Use
the search bar to locate the feature you want to use."

n In this case, the Fragments Per Limit level is set to 3.

Fragment Char-
acter Limit

This sets the character limit of the fragment phrase used in the search.

Include stop-
words in search

Flare has a hard-coded stop words list that works behind the scenes to fil-
ter out common structure-class words (i.e., function words) from search
operations. This means the Flare search engine excludes words (e.g.,
"an," "for," "of, and "the") by default. However, if you want the search
engine to search for queries with these words, you can include the stop
words list in search.
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Field Name Description

Partial word
searching

This allows part of a word to be searched in the target database. For
example, the string "sear" could return results for "search." The minimum
word size field can be set from 3-100.

NOTE: Enabling this setting could increase the build time and the
size of the search index for your target.

Advanced Search Options

Include Import-
ance (recom-
mended)

In HTML5 output, the Flare search engine uses a combination of factors
to rank search results. When you search, the search engine considers the
number of links to a topic (Importance) as well as the number of times a
search term appears in a topic. This gives you the most accurate results.
You can choose to turn off Importance and search using only the number
of search term hits in each topic. This is not recommended unless you
have one topic that is linked to so many times that it would skew your
search results.
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Field Name Description

Include fuzzy
matches

Fuzziness occurs when two words are spelled in such a similar fashion
that they could be considered the same word. There are several
instances of fuzziness that can take place:

n Substitution: tabs could be construed as tags

n Insertion: tab could be construed as table

n Deletion: server could be construed as sever

n Transposition: file could be construed as flies

n Multiple edits: imeg > image. The first edit was substituting e for i.
The second edit was inserting e at the end of the string to find the
word image.

By enabling this setting, this allows the following fuzzy matches:

n Allows zero edits for strings of one or two characters (i.e., to, by,
on)

n Allows one edit for strings between three to five characters (i.e.,
rnu could be construed as run, flies could be construed as file,
hleps could be construed as helps)

n Allows two edits for strings greater than five characters (i.e., sievrly
could be construed as severely)
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Field Name Description

NOTE: Sometimes a search string is stemmed when displaying
the search results. Stemming is when a word is reduced to its
root. For example, say you enter a search criteria for "important."
If this word is stemmed, then Elasticsearch may return fuzzy
matches for "importing." This occurs because the initial search
criteria has been stemmed to the root "import."

Auto-complete Results

Enabled This option enables the other options in this area. If this box is not
checked, all of the other options in this area are disabled.

Number of res-
ults

This field sets the limit of personal searches that display in the drop-down
while entering the search string. This can be set from a value of 1-25.

Include project
content

This displays the topic title, the path of where the topic resides in your
project, and the file name based on the search criteria. These results are
displayed with a topic icon.
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Field Name Description

Include search
history

This includes a mix of personal and global searches in the output.

Global search
threshold

This threshold determines the minimum number of times a term must be
searched from unique IP addresses before it becomes a global search
term. This threshold can be set from a value of 0-10000.

n Assuming that this field is set to a value of 50, if the term "auto-
completion" is searched from 49 unique IP addresses on your
HTML5 output, "autocompletion" does not become a global search
term until that term is searched from a 50th unique IP address.

Sitemap

Generate
Sitemap

This box should be checked to generate the sitemap required for Elastic-
search on your output.

Web URL This is the URL used for your published output.

Administrator Tools

Target GUID Provides the key used to identify and link a target to the corresponding
Elasticsearch index.

Generate GUID Generates the key to be used by the target for the Elasticsearch index.

Launch Content
Services

Opens the target in the content services portal. You can manage your tar-
gets, and search indexes in the portal.

5. Click to save your work.
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Creating Publishing Destinations for Elasticsearch
Elasticsearch is tied to your target—and therefore your output—through the use of publishing des-
tinations. You must create both a primary destination and an Elasticsearch destination. With the
primary destination, you tell Flare where to send your output files. With the Elasticsearch des-
tination, you specify where your search indexing data should be stored (i.e., the server location that
is set up by your network administrator).

HOW TO CREATE A PRIMARY DESTINATION

1. In the Project Organizer, right-click the Destinations folder and select Add Destination.

2. Give the file a name and click Add.

3. Complete the fields in the Destination Editor, depending on how you want to transfer a copy of
your output files to their destination (e.g., FTP, SFTP). For details about the available options,
see the online Help.

4. Click to save your work.

NOTE: You have the option in the Destination Editor to choose “File System” as the method
for transferring files. In this case, you would be storing the copy of your output files to a
local folder instead of transferring them remotely. You might choose to do this if you prefer
to use a third-party tool to then move those files up to the server hosting your output.

If you choose to publish your files locally in this way, you must have Java Development Kit
(JDK) version 8 installed: Download for JDK 8.

HOW TO CREATE AN ELASTICSEARCH DESTINATION

1. In the Project Organizer, right-click the Destinations folder and select Add Destination.

2. Give the file a name and click Add.

3. In the Destination Editor, click the drop-down arrow for the Type field and select
Elasticsearch.

4. Enter the Search Destination URL. This is the location provided by your network administrator
where the search index files will be uploaded for your output.

5. Click to save your work.
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Associating Elasticsearch Destinations with a Target
Now that the Elasticsearch destinations have been created, you need to associate them with your
HTML5 target.

HOW TO ASSOCIATE ELASTICSEARCH DESTINATIONS WITH A TARGET

1. From the Project Organizer, open the target that you want to associate with the destinations.

2. Click the Publishing tab.

3. Click the check box in the Publish column next to the primary destination file that you created.

4. Click the drop-down arrow in the Elasticsearch Destination column and choose the Elastic-
search destination file that you created.

NOTE: Elasticsearch destinations will not display in the list of destinations on the Pub-
lishing tab in your Target Editor. This is because you will select one from the Elastic-
search Destination field on the Publishing tab of the Target Editor.

5. Click to save your work.
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MadCap Process Manager
The Process Manager is a background process that manages the Elasticsearch service and the
Flare web service. This process can be found in the system tray. It is initiated when the Content Ser-
vices Portal is launched. See "Content Services Portal" on the next page.

The MadCap Process Manager continues to run even after Flare is closed. This process allows any
Elasticsearch output to continue running.

If you need to troubleshoot your Elasticsearch output, you will need to stop the Elasticsearch pro-
cess from running through the MadCap Process Manager. In order to do that, find the MadCap Pro-
cess Manager icon in your system tray. Then, select Elasticsearch Service > End Process.

Once you are done using the Content Services Portal or any output configured with Elasticsearch,
you can end the MadCap Process Manager by ending the task in Task Manager.
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Content Services Portal
The Content Services Portal is used to manage your search indexes. You can review and manage
your search indexes by topic, user searches, and global searches on each of your Elasticsearch tar-
gets.

HOW TO ACCESS THE CONTENT SERVICES PORTAL

1. Open a project.

2. Open an HTML5 target that has been built using Elasticsearch as the search engine.

3. Click the Search tab in the Target Editor.

4. After all of the settings have been configured for Elasticsearch, click the Launch Content Ser-
vices button.

CHAPTER 11  199



MANAGING SEARCH INDEXES

You begin at the All Targets window in the portal. This window displays all HTML5 targets using
Elasticsearch. You can access search data by an individual target.

Selecting an individual target displays the Summary window for it. This window shows the total num-
ber of searches done on the target, number of files that can be searched in the target, and users
that have searched on the target. The bottom half of this window displays the settings you con-
figured in your Elasticsearch target.
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If you click the red Topics button in the top left corner, the Topics window displays the total number
of files searched on this target. You can enter a string in the search field to filter the list of files dis-
played in this window.
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Clicking the blue button displays the number of user searches for the specific target. This window
displays the search criteria from each individual search, along with the IP address of the user that
conducted the search. You have the option to delete individual search criteria, or delete all of the
individual user searches for your target.
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The Global Searches window is displayed when you click the green button on the Summary window.
The Global Searches window shows each search criteria, along with the number of times that par-
ticular search string has been searched for your Elasticsearch target. The number displayed in the
Search Count field increments higher when a specific string is searched by different IP addresses.
So if the same IP address has searched a certain search string multiple times, the Search Count
number does not increment higher for that particular IP address.
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Google Search
Supported In:

Google Search can be utilized in your HTML5 Top Navigation or Side Navigation output. Using
Google Search provides some of the following configurable options:

n Verify the URL

n Add a sitemap

n Submit the site for indexing

n Exclude the TOC from indexing

n Customize how the results display

n Review indexing status

HOW TO SET UP A GOOGLE SEARCH ENGINE

1. Open an HTML5 target.

2. Select the Search tab.

3. From the Search Engine field, select Google Search.

4. There are several additional steps you can complete in your Google account to optimize your
search. Not all of these extra steps are required for integrating search with Flare, but they are
recommended. Also, the exact steps that you follow may be somewhat different if you are
using a free Google account as opposed to a paid account.

GOOGLE ACCOUNT—CREATE SEARCH ENGINE

a. Go to cse.google.com and log in with your Google (i.e., gmail) password.

b. Click Add to create a custom search engine.
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c. In the Sites to search field, enter the URL for the site where your output will be pub-
lished. A name for the search engine is automatically added toward the bottom of the
page, based on your URL. You can edit the name to something more simple if you want.

d. Click Create.

e. On the next page, click Control Panel to retrieve your search engine ID. (You can also
use one of the other methods—Get code or Public URL—if you prefer.) Then click
Search engine ID.
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f. Copy the ID shown in the popup.

g. Continue with the following Flare steps to enter the Google search key and generate a
sitemap.
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FLARE PROJECT—ENTER GOOGLE SEARCH KEY AND GENERATE SITEMAP

a. Return to the HTML5 target (Search tab) in the Flare project.

b. In the Google Search Context Key field, paste the ID that you copied from cse.-
google.com.

c. To assist with indexing, we also recommend that you create a sitemap. So Click Gen-
erate Sitemap and enter the same URL that you provided on your Google account page
(make sure you include http:.// before the path; also, make sure you end the path with a
closing /).

d. Click to save your work.

CHAPTER 11  208



e. Generate the target and upload the output files to your URL.

f. Continue with the following steps to verify your URL.
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GOOGLE ACCOUNT—VERIFY URL

a. In your browser, open a new tab and go to
https://www.google.com/webmasters/tools/.

b. Click Add a Property.

c. In the popup, enter the URL for your site, and click Add.

A page opens with steps for verifying your site.

d. Complete the steps on the page.

e. After you have successfully verified the site, continue with the following steps to add
your sitemap.
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GOOGLE ACCOUNT—ADD SITEMAP

a. Either click Continue under the congratulations message, or click Search Console at the
top of the browser page.

b. Navigate to Crawl > Sitemaps.

c. Click Add/Test Sitemap.

d. In the popup, enter Sitemap.xml.

e. Click Submit.
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f. Refresh the page to see the results.

g. Continue with the following steps to submit the site for indexing.
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GOOGLE ACCOUNT—SUBMIT SITE FOR INDEXING

a. In the Google Search Console, click Fetch as Google.

b. In the text field, enter a page in your output that contains many links. For example, in
the Top Navigation and PDF Advanced project template in Flare, the “Home.htm” topic
is the landing page and contains links to multiple topics, so in that case you would enter
Content/Home.htm in the field.

c. Click Fetch and Render.

d. After the status finishes processing, click Request indexing.

e. In the popup, click I’m not a robot.

f. Click Crawl this URL and its direct links.

g. Click Go.

h. Continue with the following steps to exclude your TOC from indexing.
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GOOGLE ACCOUNT—EXCLUDE TOC FROM INDEXING

By default, Google will index each word it finds on your pages, but there may be some words
that you do not want to be indexed. This likely includes your TOC. After all, the words in the
TOC will be repeated on most, if not all, of your pages. So it wouldn’t be useful for those words
to be included in searches.

a. Go back to the first browser tab for your Google account and click the Advanced tab.

b. Click CSE context to expand that section.

c. Click Download (XML). The cse.xml file is added to the Downloads folder on your com-
puter.
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d. Edit the downloaded context file cse.xml to add the following attribute: enable_
nocontent_tag=“true”. (If you already see this attribute in the file, you do not need
to add it.)

To add the attribute, you can open the file in a text editor such as Notepad++. Then near
the top of the file, change:

<CustomSearchEngine id= “[id]” creator=“[id]”>

to

<CustomSearchEngine id= “[id]” creator= “[id]” enable_nocon-
tent_tag=“true”>

There may be other attributes that are already in the tag as well. Save your changes
when finished.

EXAMPLE

Here is an example of an edited cse.xml file:

e. On your Google account page, go back to the CSE context section of the Advanced tab,
and click Upload XML file.

f. Choose the cse.xml file that you edited.

g. In the popup, click OK to upload the file.

h. Continue with the following steps to customize the appearance of search results.
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GOOGLE ACCOUNT—CUSTOMIZE APPEARANCE OF SEARCH RESULTS

By default, search results are overlayed on top of your output. You can change this look if you
want.

a. Click Look and feel.

b. On the Layout tab, select an option.

NOTE: In your Flare output, the results layout that you select may not look pre-
cisely the way that Google presents them in the layout thumbnails. It is recom-
mended that you try different layouts and test the output to see which one best
meets your needs.

TIP: To make the search results appear the way that they normally do in Top
Navigation output, select Results Only.

c. Click Save.
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GOOGLE ACCOUNT—REVIEW INDEXING STATUS

From your account, you can see the progress of your indexed pages.

a. Go back to the second browser tab showing your Google Search Console.

b. Expand Crawl and click Sitemaps.

It might be awhile before you see actual results, so return to this page periodically.

5. Click to save your work.
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MadCap Search
Supported In:

This is Flare's built-in search engine. When the target is created, it is set to use MadCap search as
the search engine. The search rankings utilize heading styles, index keywords, and glossary terms.

You can set the following configurable options using MadCap search:

n Search result importance

n Glossary terms in the results

n Number of search results per page

n Abstract character limit

HOW TO SET UP A MADCAP SEARCH ENGINE

1. Open an HTML5 target.

2. Select the Search tab.

3. From the Search Engine field, select MadCap Search.

4. You can complete the following options to optimize the search:

Field Name Description

Search Results

Results Per Page You can change the number of search results that appear on each page. This
makes it easier for users to navigate between pages of search results and
improves loading times, especially for users who access your output from a
mobile device. Setting a reasonable number of results per page also makes it
easier for search indexing services (i.e., spiders, crawlers, or bots) to locate
pages in your output, improving search results. See "Setting the Number of
Search Results Per Page" on page 232.
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Field Name Description

Abstract Char-
acter Limit

In HTML5 output, you can set a character limit for automatically gen-
erated abstracts that appear in your search results. This allows your
users to see a brief summary of each topic in the search results, while
keeping the search results page easy to scan. You can set the char-
acter limit as long or as short as you like. When creating an automatic
abstract, Flare scans all text elements in the topic, including headings
and paragraphs, and includes them in the abstract until the character
limit is met. See "Setting the Search Abstract Character Limit" on page
222.

Partial word
searching

This allows part of a word to be searched in the target database. For
example, the string "sear" could return results for "search." The Min-
imum word size field can be set from 3-100.

NOTE: Enabling this setting could increase the build time and
the size of the search index for your target.

Advanced Search Options

Include Import-
ance (recom-
mended)

In HTML5 output, the Flare search engine uses a combination of
factors to rank search results. When you search, the search engine
considers the number of links to a topic (Importance) as well as the
number of times a search term appears in a topic. This gives you the
most accurate results. You can choose to turn off Importance and
search using only the number of search term hits in each topic. This is
not recommended unless you have one topic that is linked to so many
times that it would skew your search results. See "Setting Search Res-
ult Importance" on page 228.

Include Glossary
Terms

For HTML5 output, search results display glossary terms if they are
used as the search text. This option to display glossary terms in search
results is enabled by default. However, it can be turned off in the
HTML5 Target Editor. See "Including Glossary Terms in Search Res-
ults" on page 224.
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Field Name Description

Exclude non-
words from
search

If you have a project that contains a lot of content that is not com-
posed of regular letters and numbers (e.g., angled brackets), you can
set your target to avoid these "non-words" when users perform a
search in your Help system. This will improve the search performance
that your users experience. See "Excluding Non-words from Search" on
page 31.

Exclude index
entries from
search

If you insert index markers in your project, those markers by default are
included in searches that users perform in your output. If you want to
exclude index entries from searches, you can do so. See "Excluding
Index Entries From Search" on page 29.

Pre-merge Search
Database File

If you have multiple projects whose outputs are set to be merged when
you build the "master" project, you can pre-merge search database
files. If you select to pre-merge the search database file, you disable
runtime merging, which means that you cannot compile and publish a
"sub-project" later. You must generate and publish all linked Help sys-
tems at the same time. Selecting this option may slow down the gen-
eration of the output, but it will significantly increase the speed with
which the output loads for the end user.

Chunk large
search database
file

You can control the size of "chunks" used when generating the search
database files for a target. After you choose this option, select the
number of bytes for each chunk. The chunk size affects the speed that
a Help system loads for a user. Depending on the Internet connection,
different results will be seen. The smaller the chunk size, the greater
the number of chunks that will be sent. A large number of chunks may
result in a slower speed, especially if you have many merged "sub-pro-
jects" and the index is being merged. Chunking may slow down the gen-
eration of your output somewhat, but it increases the speed that the
output loads for end users. For best results, you should test the dif-
ferent chunk sizes. Click the drop-down next to the Maximum chunk
size field to set the maximum size of your search database file.
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Field Name Description

N-Gram Size You can adjust the n-grams, which are character chunks used to sep-
arate words in Chinese, Japanese, and Korean projects. Chinese,
Japanese, and Korean languages do not have spaces as word bound-
aries, so n-grams are used to separate the words. Smaller n-gram val-
ues produce smaller search database file sizes. They also lead to more
search results, which may be less accurate. On the other hand, larger
n-gram values produce larger search database file sizes. They also
lead to fewer search results, which may be more accurate. The default
size in this field is optimal for most situations.

Sitemap

Generate Sitemap For web-based targets, you can generate a sitemap when compiling
your output. This helps with search engine optimization (SEO), making
it easier for search indexing services (i.e., spiders, crawlers, or bots) to
find your output. Therefore, the entire output is indexed and search
engine results are improved. See "Generating Sitemaps for SEO" on
page 234.

Web URL This is the URL used for your published output.

5. Click to save your work.
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Setting the Search Abstract Character Limit
Supported In:

In HTML5 output, you can set a character limit for automatically generated abstracts that appear in
your search results. This allows your users to see a brief summary of each topic in the search res-
ults, while keeping the search results page easy to scan. You can set the character limit as long or
as short as you like. When creating an automatic abstract, Flare scans all text elements in the topic,
including headings and paragraphs, and includes them in the abstract until the character limit is
met.
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HOW TO CHANGE THE ABSTRACT CHARACTER LIMIT IN SEARCH RESULTS

If you want change the abstract character limit, do the following.

1. Open an HTML5 target.

2. Select the Search tab.

3. Select MadCap Search in the Search Engine field.

4. In the Abstract Character Limit field, enter the number of characters you want to allow in the
topic's abstract. By default, the number of results per page is 300.

5. Click to save your work.

NOTE: In order to use this field, you must be using MadCap Search. Elasticsearch uses a
similar field called Fragment character limit. This feature is not supported for Google
Search (see "Google Search" on page 205).

NOTE: Setting the abstract character limit to 0 will remove the abstract completely.

NOTE: If a word is too long and would push the abstract past its character limit, it is not
included in the abstract. Flare will not leave incomplete words at the end of the abstract.

NOTE: If you need to provide a longer or shorter search abstract, or if you do not like the
default text that appears in the abstract, you can manually enter a meta description for the
topic in the topic's Properties dialog.

See "Meta Descriptions for Topics" on page 260.

CHAPTER 11  223



Including Glossary Terms in Search Results
Supported In:

For HTML5 output, search results display glossary terms if they are used as the search text. In order
to use this feature, you must be using MadCap Search. This feature is not supported for Google
Search (see "Setting Up a Search Engine" on page 169).
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HOW TO INCLUDE GLOSSARY TERMS IN SEARCH RESULTS

1. Open an HTML5 target.

2. In the Target Editor, select the Search tab.

3. In the Search Engine field, make sure MadCap Search is selected.

4. Select Include Glossary Results to enable the feature.

5. Click to save your work.

NOTE: In order for a glossary term to display in the search results, the end user's search
text must match the glossary term exactly, with no additional words (although it is not case-
sensitive). For example, in the example above, only the word "table" was included in the
search; therefore, the glossary term "Table" was displayed. But if we had searched for "table
topic," no glossary term would have been displayed in the search results.

NOTE: If you open a Side Navigation, Top Navigation, Tripane, or Search Results skin, you
will notice Search Glossary styles that let you control the look of this new feature (e.g.,
change the font color to make it stand out from the other search results). The Search Gloss-
ary Result style is used to control the entire area displaying the glossary search result. The
Search Glossary Term and Search Glossary Definition styles are used to control the look of
only the term and definition, respectively.
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Setting Search Result Importance
Supported In:

In HTML5 output, the Flare search engine uses a combination of factors to rank search results.
When you search, the search engine considers the number of links to a topic (Importance) as well
as the number of times a search term appears in a topic. This gives you the most accurate results.
You can choose to turn off Importance and search using only the number of search term hits in
each topic. This is not recommended unless you have one topic that is linked to so many times that
it would skew your search results.  You must be using Elasticsearch or MadCap Search to use this
feature. It is not supported for Google Search.

HOW TO INCLUDE OR EXCLUDE IMPORTANCE IN SEARCH RESULTS

1. Open an HTML5 target.

2. Select the Search tab.

3. From the Search Engine section, make sure MadCap Search or Elasticsearch is selected.

4. Expand the Advanced Search Options section.

5. Select Include Importance.

6. Click to save your work.
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EXAMPLE

Here is an example of a search with Importance turned on.
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Here is an example of a search in the same content with Importance turned off.
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Notice how the search results are different. This is because in the first example, with
Importance turned on, the search engine considers the number of links to that topic
when ranking the search results. In the second example, the results are ranked only
using the location of the search term in the topic (e.g., in a heading, in an index
keyword, in the body text).

If you want your users to be able to find a topic that you refer to—and link to—often in
your content, you should turn on the Importance setting so the topic appears higher in
the search rankings.

NOTE: Links that occur in a master page are not considered when calculating Importance.
For example, suppose you have a link in the master page footer that appears on every page
in your output. Because you can access the page it links to from every other page, it should
be the most important page in the output, but it is excluded from Importance rankings so it
does not skew results.
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Setting the Number of Search Results Per
Page
Supported In:

You can change the number of search results that appear on each page. This makes it easier for
users to navigate between pages of search results and improves loading times, especially for users
who access your output from a mobile device. Setting a reasonable number of results per page also
makes it easier for search indexing services (i.e., spiders, crawlers, or bots) to locate pages in your
output, improving search results. In order to use this feature, you must be using MadCap Search.
This feature is not supported for Google Search (see "Setting Up a Search Engine" on page 169).
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HOW TO CHANGE THE NUMBER OF SEARCH RESULTS PER PAGE

1. Open an HTML5 target.

2. Select the Search tab.

3. From the Search Engine section, make sure either MadCap Search or Elasticsearch is selec-
ted.

4. In the Results Per Page field, use the arrows to set the number of results you want to display
on each page. By default, the number of results per page is 20 for MadCapSearch and 100 for
Elasticsearch.

5. Click to save your work.
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Generating Sitemaps for SEO
Supported In:

For web-based targets, you can generate a sitemap when compiling your output. This helps with
search engine optimization (SEO), making it easier for search indexing services (i.e., spiders, crawl-
ers, or bots) to find your output. Therefore, the entire output is indexed and search engine results
are improved.

HOW TO GENERATE A SITEMAP FOR SEARCH ENGINE OPTIMIZATION

1. Open a web-based target.

2. On the Search tab of the Target Editor, select Generate Sitemap.

3. In the Web URL field enter the path where the output is ultimately published. For example,
http://help.madcapsoftware.com/flare2018/.

NOTE: Be sure to include the full path—including "http://"—when entering the web
URL.

4. Click to save your work.

NOTE: If you are generating HTML5 output, you can also set up your search engine—
MadCap Search, Google Search, or Elasticsearch (for Top Navigation, Side Navigation, or
skinless outputs). See "Setting Up a Search Engine" on page 169.
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Ranking Search Results
The Flare search database generates organic search results and looks at numerous signals, factors,
and metrics to determine how relevant the results are to the query terms. Understanding how
searches are ranked in the different output types helps you determine strategies for optimizing your
search results.

Ranking Results—HTML5, DotNet Help, WebHelp, WebHelp,
AIR, WebHelp Mobile
Flare's search engine uses content signals and content weighting to determine search rankings.

Content Signals
When end users enter their query terms in output, the search engine looks at a variety of signals,
such as:

n Do the search terms occur in the topic title?

n Do the search terms occur in a heading tag, and at what level (e.g., H1, H2, H3)?

n Do the search terms occur in the abstract text or meta description?

n Do the search terms occur in an index marker in the topic?

n Do the search terms occur in a glossary term?

n Do the search terms occur in the topic's body?

n How many times do the search terms occur in each location (e.g., topic title, hyperlinks, body
text)?

These items are used to determine the topic's search ranking against other topics.

Content Weighting
As with most search engines, Flare takes a variety of factors into account when ranking its search
results. Since retrieved results are relative to the search query and indexed content, the table below
describes in general terms how different content elements are ranked:
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Content Ele-
ments

Description

Title Tags The topic title lets readers know the topic of a particular page. It is placed in a
<title> tag, within a <head> tag in HTML documents.

You can add a topic title by right-clicking the topic in the Content Explorer, and
selecting Properties from the context menu. In the Properties dialog, click the Topic
Properties tab, and enter text in the Topic Title field.

You also have the option to leave the Topic Title field blank. If you do this, the first
topic heading will be used as the topic title by default.

Topics with a keyword in the <title> tag always appear first in search results, and
always are ranked higher than topics where a keyword appears elsewhere in the
topic, regardless of how many times the keyword appears. This helps you find the
most expected topics when running a search.

NOTE: If you do not have a <title> tag in your topic, Flare uses the first head-
ing in the topic as the title tag for the file. If there are no headings in the
topic, the file name acts as the title tag. This text is given the same search
ranking as a <title> tag.

H1 Heading
Tags

Keywords contained in an <h1> tag are given less weight than the topic title, but are
still an important factor.

Subsequent
Heading
(H2-H6)
Tags

The search engine also looks in topics for keywords in <h2> through <h6> tags.
These tags are decreasingly less important to content ranking (e.g., <h2> receives a
higher rank than <h3>, <h3> receives a higher rank than <h4>).
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Content Ele-
ments

Description

Abstract
Text

The search engine looks at text in the topic's abstract. Keywords in the abstract
receive the same ranking as keywords in <h2> tags.

NOTE: This only applies to keywords in the meta description that you
define in the topic's properties. If you do not set an abstract in the topic
properties, Flare will generate an auto-abstract using the abstract char-
acter limit. However, this is not considered abstract text for search ranking
purposes. Instead, these keywords are ranked according to their tags in the
Flare topic (e.g, <p>, <h3>). See "Meta Descriptions for Topics" on page 260
and "Setting the Search Abstract Character Limit" on page 222.

Index Key-
words in
Topics

The search engine looks at topics for index keywords. Index keywords in a topic
have the same weight as keywords in <h4> tags.

NOTE: If you do not want index keywords to be considered when retrieving
search results, you can exclude them from the search. See "Excluding
Index Entries From Search" on page 29.

Glossary
Terms

The search engine looks at topics for glossary terms. Glossary terms in a topic have
the same weight as keywords in <h5> tags.

Keywords in
the Body
Text

Keywords that appear in the body text are ranked the same as keywords in
<h6> tags.
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Content Ele-
ments

Description

Keyword
Frequency

The search engine looks at how many times the search term appears in each topic.
Topics with frequent keywords are ranked higher than topics with fewer keywords.

NOTE: While topics with more frequent keywords are ranked higher, they
will never outrank a keyword with a higher base weighting.

EXAMPLE

Let's say you have two topics that are almost identical. However, the
search term appears in a Heading 2 three times in the first topic and
only two times in the second topic. Because the search engine
accounts for frequency, the first topic will appear higher in the search
results than the second topic.
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Content Ele-
ments

Description

EXAMPLE

Let's say you have two topics. In the first, your search term appears
many times, all in Heading 4s. In the second it appears once, in a Head-
ing 3. The second topic will appear higher in the search results
because even though the search engine accounts for frequency,
search terms that appear in a Heading 3 still take priority over search
terms that appear in a Heading 4, regardless of how many total times
they appear in the topic.

NOTE: In HTML5 outputs, the Flare search engine uses one additional concept to rank
search results: Importance.

A topic's importance is determined by the number links to a topic in the output. A topic that
is linked from ten other topics is more important than a topic that is only linked from one
other topic. See "Setting Search Result Importance" on page 228.
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Ranking Results—Server-based HTML5 and WebHelp Plus
If you enable server-based output for HTML5 or WebHelp Plus, the Flare the search engine is sup-
ported by one of these tools:

n Microsoft Indexing Service To learn about the Microsoft Indexing Service, see Microsoft's doc-
umentation. Here is a link to get you started:

http://technet.microsoft.com/en-us/library/cc723263.aspx#XSLTsection123121120120

n Windows Search Service To learn about the Windows Search Service, see Microsoft's doc-
umentation. Here is a link to get you started:

http://msdn.microsoft.com/en-us/library/windows/desktop/aa965362(v=vs.85).aspx

See "HTML5 Server-based Output" on page 80 or "WebHelp Plus Server-based Output" on page 102.

Ranking Results—Eclipse Help
Search is provided by the Eclipse platform. You can configure a variety of different search options in
Eclipse. For more information, see the Eclipse documentation: help.eclipse.org.
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Optimizing Your Content
There are a variety of tasks you can perform to optimize your content. This includes adjusting topic
titles, heading tags, file names, index keywords, body text, and meta descriptions. You can also
determine whether or not the search engine considers how many internal links there are to a topic
when considering that topic's search result ranking.

Topic Titles
For Flare and for search engine providers, the topic title is one of the most important considerations
taken into account when ranking search results. Topic titles are important because in addition to
including important keywords, as shown below, titles are also highly visible elements in search res-
ults:

Where Topic Titles are Visible

Flare Search Results

Web Browsers

Search Engine Results

Social Media Bookmarks

Here are some recommendations for improving the quality of your topic titles for search optim-
ization:

n Give Each Topic a Unique Title Every page in your output should have a unique topic title. It
should also accurately describe the page content.

n Add Only One Title Per Topic A page should have only one title. For best results, it should be
contained in the <Title> tag. In Flare, you can set the topic title in the Topic Properties tab of
the Properties dialog. You have the option to always use the first topic heading as the title or
you can manually enter a topic title.
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EXAMPLES

In the topic Properties dialog, you can use the first heading in each topic as the
topic title by default. When you use this option, the topic title is not included
within a <head> tag on the page.

You also have the option of manually typing a topic title in the Topic Title field of
the Topic Properties tab. When you use this option, the topic title is included in a
<title> tag within the <head> tag on the page.
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n Contain the Title Tag in the Head Tag Most search engine optimization (SEO) experts agree
that you can improve page rank if you include the topic <title> tag within the <head> tag.

EXAMPLE

Below is an example of the HTML code for a topic title:

<head><title>Feeding a Cat</title></head>

In order for the title "Feeding a Cat" to appear in a <title> tag within the <head>
tag, open the Properties dialog for the topic. In the Topic Title field, type the title:

Below is an example of how the title appears in the Flare Text Editor:
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n Limit Title Length to 70 Characters Because topic titles display in search engine results,
experts recommend limiting page titles to a maximum of 70 characters, including spaces.
This increases the odds of end users clicking the link.

EXAMPLE

Because titles display on search engine results pages, titles should be limited to a
maximum of 70 characters (including spaces).

n Place Important Keywords at the Front of the Title Tag For best results, order keywords in a
title from most important to least important. For example, if you anticipate that your end
users use query terms such as "Online Help Writing," it may be preferable to ensure the terms
Online and Help are at the front of the title tag. For example, "Writing Online Help" or "Online
Help Writing"
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n Place Keywords at the End of a Title If you want to include your company branding or project
name in a title, it is recommended that you place those keywords at the end of the title.

EXAMPLE

If you want to include branding keywords, place them at the end of the topic title.

Heading Tags
Heading tags are important page elements. Below are some best practices for optimizing your head-
ing tags:

n Include Important Keywords in the <h1> Tag Because the text in the <h1> tags are used for
search categorization, they should always contain important search keywords.

n Limit <h1> Tags to One Per Page You should always apply the <h1> tag to the most important
heading text in a document. As a general rule, it is best to include only one <h1> tag per page.

n Keep <h1> Tags Unique Because search engines score unique pages higher, it is best that the
content of an <h1> tag is unique from other <h1> tags in a project.
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Index Keywords
Some search engines may also recognize the index keywords that you include. The Flare search
engine also looks at index keywords when ranking search results, so make sure that you insert
important keywords into your topics.

EXAMPLE

Here is an example of an index keyword in the XML Editor.
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Body Text
The Flare search engine considers keywords in the body text when ranking search results. While the
search algorithm is different, major search engine algorithms also consider keywords in the body
text.

BEST PRACTICES FOR BODY TEXT

Following are some best practices when it comes to body text.

n Include Keywords in the Topic Abstract For best results, carefully craft your paragraphs to
include your most important keywords in the first paragraph of the topic. Flare's search
engine places a high preference on keywords found in this paragraph, which acts as the topic
abstract.

NOTE: If you use a meta description, the information in the meta description appears
in the search result instead of the topic abstract. See "Meta Descriptions for Topics"
on page 260.

n Use Important Keywords in Heading Tags You should always include the most important
keywords in the heading tags, as most search engines give headings more weight.

n Apply Emphasis to Keywords Some, but not all, search engines give preference to keywords
where bold or italics are applied. The Flare search engine weighs text with inline tags (i.e,
formatting applied with span tags) slightly higher than regular text.

n Consider the Frequency of Your Keywords Consider the number of times you use a keyword
on a page. Flare's search engine places gives preference to topics that use a keyword often.

n Include Hidden/Invisible Text You can optionally include hidden/invisible text as described
below.
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HIDDEN/INVISIBLE TEXT

You can modify your project stylesheet if you want to include hidden/invisible text. This makes the
text invisible to the users viewing the topic, but it will be visible to the indexing programs used by
some search engines.

For the Flare search engine, it is acceptable to use invisible/hidden text to influence search results.

You might use hidden/invisible text on additional headings to give the topic more weight with search
engines.

IMPORTANT: Be careful about using invisible/hidden text for the purpose of keyword
stuffing. For example, you should not include large blocks of hidden text in a topic because
it can lead to major search engine providers temporarily or permanently blocking your con-
tent from their site. For that reason, it is recommended that you always research the cur-
rent content standards for your desired search engines.
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HOW TO CREATE A HIDDEN TEXT STYLE

You can create a hidden/invisible text style for any style in your project.

1. From the Content Explorer, open the stylesheet that you want to modify.

2. In the local toolbar, make sure the first button displays . If the button dis-

plays instead, then click it.

3. In the drop-down field on the left, choose Heading Styles from the list. For this example, we
will show you how to create a hidden style class for your h1 tags.

4. Right-click the h1 and select Add Selector from the context menu.

The New Selector dialog opens.
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5. In the Class Name field, type a name for your style. In this example, we will name it Hid-
denH1.

The new class appears in the stylesheet under the h1 tag.

6. In the Properties area, expand the Block properties.
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7. Next to the display field, select none from the drop-down list. Selecting none here will let you
see the element in the XML Editor and Text Editor. It will be visible to web crawlers and
spiders in the code, but completely hidden from your end users in the target output.

8. Save your changes.
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HOW TO APPLY A HIDDEN/INVISIBLE TEXT STYLE

After you create a hidden/invisible text style, you can apply it to content, such as additional
headings. In this example, we show you how to apply the hidden style you just created to the first-
level heading.

1. Open the desired topic.

2. Add the text that you want to be hidden/invisible. In this example, we will add a duplicate
<h1> heading in a topic.

3. Right-click on the heading text and from the context menu, choose Style Class > h1Hid-
denH1.
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The illustration below shows you how the hidden text style appears in the XML Editor.

4.  Preview the new style in your output.
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Meta Descriptions
You can use a text editor to add a meta description (summary or abstract) manually to a topic.
However, an easier method is to use the topic's Properties dialog in Flare to add them. Meta descrip-
tions are supported for HTML5, WebHelp, and WebHelp Plus targets. See "Meta Descriptions for
Topics" on page 260.

A meta description is typically not an important consideration for ranking results. However, many
(but not all) search engines display meta descriptions as page summaries in search results.

In Flare, meta descriptions are weighted heavily when ranking search results. In addition, meta
descriptions are used to display topic summaries on the search results page of the output. This is
also true for many, but not all, search engine providers.

If you include a meta description in a topic in an output type using the Flare search engine, the
description will always be displayed as the page summary in the search results, rather than of the
first paragraph of the topic.

EXAMPLE

Below is an example of a meta description that has been added using the topic's Prop-
erties dialog.
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If you decide to include a meta description for your topic, the text you write will appear
in the summary field of the Flare search results. The same is true for some, but not all,
major search engine providers.
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GUIDELINES FOR WRITING META DESCRIPTIONS

While not always used for ranking, most major search engine providers identify content with meta
descriptions as sign of higher-quality content. Also, because end users read meta descriptions and
make decisions as to whether or not to visit a page, it is generally a good practice to write meta
descriptions that satisfy these minimum guidelines:

n Create Readable and Well-Written Descriptions It is beneficial to add a high-quality meta
description to your topics. Just after the title on a search results page, a well-written meta
description can influence a person's decision to click to view a page. This, in turn, typically
improves the quality and quantity of page visits from Internet search traffic.

n Provide Searcher with an Accurate Description of Page Content Think of a meta description
as part page summary and part advertisement. You want your descriptions to contain
descriptive keywords, and since it will also be displayed in search results, you want it to be
readable, concise, accurate, and to the point. A description should always provide a summary
of the content on a page. To avoid creating confusion, disappointment, or frustration for end
users, never load a meta description with repetitive keywords, inaccuracies, or promises that
they will find information that isn't actually in the body of the page.

n Contains Between 68-155 Characters Depending on which SEO experts you consult and
where you anticipate the page summary being displayed, you will find a wide variety of recom-
mendations about meta description length. The short answer is the different search engine
providers impose different limits. However, the Google limit is widely reported as being 155
characters, so as a general guideline we recommend writing descriptions between 68-155
characters in length. If you want to check the length of your descriptions, there are a wide vari-
ety of tools that let you cut and paste text into their counter. Simply search online for "letter
count" or "word count."

n Avoid Keyword Stuffing Although it can be tempting to repeat descriptive terms in a meta
description, there is little reason to include the same words and phrases multiple times. For
example, there is no need to stuff a meta description with keywords (i.e., "Toolbar, tool bar,
toolbars, tool bars"). First, this renders the description useless to anyone trying to read the
summary. Also, most major search engine providers will flag keywords in meta descriptions as
spam which can trigger ranking penalties and result in your page (or your entire site) being dis-
regarded by their search engine.
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File Names
Flare considers file names in rankings if you do not have a <title> tag in the document. When the
Flare search engine looks at the file names in your project, it considers the following when listing res-
ults:

n Keyword Matches in File Names File names with exact keyword matches are favored. For
example, if you are searching for "choosing a cat," topics containing the keywords "choosing a
cat" will be ranked higher than file names containing "choose a cat" or "choosing cats."

n Do Not Run Keywords Together in File Names For best results with keyword recognition, it is
recommended that you do not run keywords together in file names (e.g., choosingacat.htm).
When keywords run together, there is a greater risk of the keywords not being recognized, as
well as not being parsed properly by search engines.

n Shorter File Names are Better Because file names are part of a URL, studies show that the
general rule of thumb for page URLs is that shorter URLs are better. For example, a file named
"choose-a-cat.htm" would be a more compelling link for an end user to click than a file named
"how-to-go-about-choosing-a-cat-or-a-kitten.htm."

n Use Hyphens While it is a common practice to use underscores in file names (e.g., Choosing_
a_Cat.htm), many search engine providers and SEO experts no longer recommend it because
the underscore is considered by some indexes to be its own word character. While it provides
visible separation between words, one point to consider is that some search engines might
take regular expressions such as "Choosing_a_Cat" and interpret it as "ChoosingaCat."
Because of this, some SEO experts recommend that you use hyphens to represent a space
between keywords. Whichever separator you decide to use, it is recommended that you do
not use periods (.) or blank spaces to separate words in file names. Periods are used by some
computer systems to indicate different file extension types. Blank spaces can cause issues
for Web servers, particularly those running UNIX or Linux.

n Be Aware of Case Because some major search engine providers run indexing systems on
case-sensitive servers (e.g., Apache, Unix, and Linux servers), whether a file name is written in
lowercase or uppercase can make a difference as to whether the file is indexed. For example,
a page named "choosing-a-cat.htm" may be interpreted differently from "Choosing-A-
Cat.htm." It can also lead to search engines creating duplicate page entries, which can result
in error codes when users click links, as well as penalties for content ranking. While it is dif-
ficult to predict how each and every search engine will handle a file name, it is good to pick
your file naming convention wisely and then use it consistently.
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EXAMPLE

Let's say you have a project with only five topic files. The file name for each topic uses
a different separator to represent the space between keywords (e.g., choosing a
cat.htm, choosing.a.cat.htm, choosing_a_cat.htm, and choosing-a-cat.htm. In addition,
one of the file names runs the keywords together (e.g., choosingacat.htm).

If you were to search for "choosing a cat," note how the search results will list only the
exact matches (i.e., the file name that runs keywords together is not detected as a
match). For example, "choosingacat.htm" is not listed in the results.
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Search Result Importance—HTML5 Output
In HTML5 output, the Flare search engine uses a combination of factors to rank search results.
When you search, the search engine considers the number of links to a topic (Importance) as well
as the number of times a search term appears in a topic. This gives you the most accurate results.
You can choose to turn off Importance and search using only the number of search term hits in
each topic. This is not recommended unless you have one topic that is linked to so many times that
it would skew your search results.

When optimizing your content for HTML5 output, consider if you are going to use Importance in your
searches and tailor your content appropriately. For example, if you plan to use Importance, you
should make sure you link to important topics throughout your output. However, if you do not plan
on using Importance in your searches, you should focus on adding keywords throughout your topic.

See "Setting Search Result Importance" on page 228.
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Meta Descriptions for Topics
Supported In:

You can add a meta description to a topic in the Properties dialog. Meta descriptions are brief sum-
maries of web pages and are displayed in search engine results pages (SERPs). Therefore, they are
useful for search engine optimization in HTML5, WebHelp, and WebHelp Plus outputs.

This description is stored as metadata in the <head> tag of the topic file. The markup looks like this:

<meta name="description" content="This topic provides a general intro-
duction to MadCap Flare, its benefits, and basic steps for getting
started." />

In addition, topic meta descriptions are used in the search results for HTML5 output, and they are
searchable. Keywords found in meta descriptions receive a ranking in search results.
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If you do not provide a meta description, Flare will use the abstract character limit to create an
abstract from the text in your topic. However, keywords found in automatically generated abstracts
receive a lower search ranking than those found in meta descriptions. See "Setting the Search
Abstract Character Limit" on page 222 and "Ranking Search Results" on page 235.

For more information and tips for using meta descriptions, see "Optimizing Your Content" on page
241.

HOW TO ADD A META DESCRIPTION FOR A TOPIC

1. Open the Content Explorer.

2. Locate and click on the topic file.

3. In the local toolbar, click . The Properties dialog for the file opens.

4. Click the Topic Properties tab.

5. In the Description field, enter the meta text.

TIP: It is recommended that you keep meta descriptions to fewer than 155 char-
acters.

6. Click OK.
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Optimizing Your Site
You can take actions to optimize the site where your output is published. This includes generating a
sitemap, including a robots.txt file, enabling non-XHTML files in search, showing navigation links,
changing search pagination, and adding search abstracts.

Generating Sitemaps
For web-based targets, you can generate a sitemap when compiling your output. This helps with
search engine optimization (SEO), making it easier for search indexing services (i.e., spiders, crawl-
ers, or bots) to find your output. Therefore, the entire output is indexed and search engine results
are improved.

HOW TO GENERATE A SITEMAP

1. Open a web-based target.

2. On the Search tab of the Target Editor, select Generate Sitemap.

3. In the Web URL field enter the path where the output is ultimately published. For example,
http://help.madcapsoftware.com/flare2018/.

NOTE: Be sure to include the full path—including "http://"—when entering the web
URL.

4. Click to save your work.
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Including a Robots.txt File
A robots.txt file is typically implemented by a webmaster or website owners. it is used to advise
search engine robots and spiders about what site content can and cannot be crawled. The robot-
s.txt protocol is a simple text file that you can create in a text editor.

There are several reasons why you may want to consider creating a robots.txt file to use with your
published output:

n Block Access to Content If you do not want the robot or spider to crawl certain content, you
may want to publish those content files in a password-protected directory and include a robot-
s.txt file. It is recommended that you work with your website or web server administrator to
ensure your requirements are met.

n Block Access to Specific Files and/or Folders If you have specific content that want to block
from search engines, you can advise cooperating robots and spiders to exclude that content
from their index. Keep in mind that most major search engines cooperate with these instruc-
tions. However, some search engines do not.

n Block Your Site from Specific Search Engines If you would like to block a specific search
engine from crawling your site, you can advise its robot or spider to exclude your site from its
index. To be successful, the robots.txt file must explicitly define the robot to block by name
and the spider must be programmed to cooperate with your instructions.
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HOW TO INCLUDE A ROBOTS.TXT FILE

1. Open a text editor.

2. Create a new file and name it "robots.txt."

3. Include the desired instructions.

TIP: To learn what to include in a robots.txt file, see http://www.robotstxt.org/. You
should discuss specific requirements with your web server administrator and/or web-
master.

4. Place the file at the root of the website hosting your published content.

EXAMPLE

Let's say you plan to publish your Help content to a site named:

https://www.help.example.com

In this scenario, you should place the robots.txt file at the root of the site:

https://www.help.example.com/robots.txt

5. Publish your content and ensure the robots.txt file is still in place.

6. Test your robots.txt using a validation tool. Some major search engines provide their own test-
ing tools (e.g., Google) .

NOTE: Most major search engines (e.g., Google, Bing, and Yahoo) are known to
cooperate with the instructions in a robot.txt file. However, many search engines also
have the ability to discover information using other methods. For example, let's say
you have blocked a file named "form_1.html" in robots.txt. However, another website
has created a link on their site to your "form_1.html" page. In this scenario, the URL for
that linked page may be included in an engine's search results.

NOTE: It is also generally understood that there are existing search engines, including
malicious ones, that do cooperate with the robots.txt protocol. Be sure to work
closely with a web developer or your web host to ensure you get the best results pos-
sible with your robots.txt file.
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Enabling Non-XHTML Files in Search
Because search engines have added non-HTML formats to their search indexes, it is helpful to
enable non-XHTML search in your output. This allows the Flare search engine to return matches for
non-HTML content in your project (e.g., PDF, DOC, and XLS files). You can enable non-XHTML
search in the HTML5 and WebHelp Plus server-based outputs. See "Including Non-XHTML Files in
Search" on page 121 and "Including Non-XHTML Files in HTML5 Search" on page 98.

Showing Navigation Links
You can add a navigation link to the top or bottom of topics in HTML5, WebHelp, WebHelp AIR, or
WebHelp Plus outputs. This navigation link will not display unless the output topic is opened as a
standalone (outside of the main navigation framework of the output). By clicking the link, a user can
view the standalone topic in the main navigation framework.
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Changing the Number of Search Results Per Page
You can change the number of search results that appear on each page in HTML5 outputs. This
makes it easier for users to navigate between pages of search results and improves search result
loading times, especially for users who access your output from a mobile device. In order to use this
feature, you must be using Elasticsearch or MadCap Search. This is feature is not suppoted for
Google Search. See "Setting Up a Search Engine" on page 169.

CHAPTER 11  266



Changing the Abstract Character Limit in Search Results
In HTML5 output, you can set a character limit for automatically generated abstracts that appear in
your search results. This allows your users to see a brief summary of each topic in the search res-
ults, while keeping the search results page easy to scan. You can set the character limit as long or
as short as you like. When creating an automatic abstract, Flare scans all text elements in the topic,
including headings and paragraphs, and includes them in the abstract until the character limit is
met. This feature is only supported for MadCap Search. See "Setting the Search Abstract Character
Limit" on page 222.

You can also add a manual search abstract using meta descriptions in the topic's Properties dialog.
See "Meta Descriptions for Topics" on page 260.
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APPENDIX

PDFs
The following PDFs are available for download from the online Help.

TUTORIALS

Getting Started Tutorial

Product Foldout Tutorial

Side Navigation Tutorial

Top Navigation Tutorial

Tripane and PDF Tutorial

USER GUIDES

Accessibility Guide Getting Started Guide

Analysis and Reports Guide Global Project Linking Guide

Architecture Guide HTML Help Guide

Autonumbers Guide HTML5 Guide

Condition Tags Guide Images Guide

Context-sensitive Help Guide Importing Guide

DotNet Help Guide Index Guide

Eclipse Help Guide Key Features Guide
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Language Support Guide Source Control Guide: Perforce

MadCap Central Integration Guide Source Control Guide: Subversion

Movies Guide Source Control Guide: Team Foundation Server

Navigation Links Guide Source Control Guide: Visual SourceSafe

Plug-In API Guide Styles Guide

Print-based Output Guide Tables Guide

Project Creation Guide Tables of Contents Guide

Pulse Guide Targets Guide

QR Codes Guide Templates Guide

Reports Guide Topics Guide

Reviews & Contributions Guide Touring the Workspace Guide

Search Guide Transition From FrameMaker Guide

SharePoint Guide Variables Guide

Skins Guide WebHelp Outputs Guide

Snippets Guide What's New Guide

Source Control Guide: Git

CHEAT SHEETS

Folders and Files Cheat Sheet

Print Output Cheat Sheet

Shortcuts Cheat Sheet

Structure Bars Cheat Sheet

Styles Cheat Sheet

APPENDIX  269


	CHAPTER 1
	Introduction
	Search Features and Capabilities
	Searching the Outputs
	Optimizing Search
	Steps for Setting Up Search


	CHAPTER 2
	Enabling Search in Skins

	CHAPTER 3
	Include/Exclude Topics in Search

	CHAPTER 4
	Configuring the Search Database
	Chunking Large Search Database Files
	Excluding Index Entries From Search
	Setting the N-Gram Size for Search
	Excluding Non-words from Search
	Enabling Partial-Word Search
	Pre-merging Search Database Files
	Including an SQL Search Database
	Including Stop Words in Search


	CHAPTER 5
	Search Filter Sets
	Adding Search Filter Set Files to Projects
	Inserting Concepts
	Creating Search Filters
	Customizing Search Filter Ordering
	Associating a Search Filter Set with a Target
	Importing Search Filter Sets
	Opening a Search Filter Set
	Search Filter Set Example


	CHAPTER 6
	Synonyms
	Tasks for Using Synonyms
	Adding Synonym Files
	Creating Synonyms to Enhance Search Results
	Exporting Synonyms
	Opening Synonym Files


	CHAPTER 7
	Search Highlighting and Styles
	Search Highlighting
	Customizing Highlighted Search Terms
	Styles for Generated Pages


	CHAPTER 8
	HTML5 Server-based Output
	Enabling HTML5 Server-based Output
	Installing IIS and ASP.NET
	Setting Up an HTML5 Target
	Configuring IIS on Production Server
	Starting Microsoft Indexing Service
	Starting Microsoft Windows Search
	Enabling HTML5 Server-based Search
	Testing HTML5 Server-based Search
	Including Non-XHTML Files in HTML5 Search


	CHAPTER 9
	WebHelp Plus Server-based Output
	Enabling WebHelp Plus Output
	Installing IIS and ASP.NET
	Setting Up a WebHelp Plus Target
	Configuring IIS on Production Server
	Starting Microsoft Indexing Service
	Starting Microsoft Windows Search
	Enabling WebHelp Plus Search
	Testing WebHelp Plus Search
	Including Non-XHTML Files in Search


	CHAPTER 10
	Searching the Outputs
	Search Methods and Syntax
	Searching a DotNet Help System
	Searching a Microsoft HTML Help System
	Searching an HTML5 System
	Searching a WebHelp System
	Searching a WebHelp Mobile System
	Searching for Community Results


	CHAPTER 11
	Optimizing Search
	Setting Up a Search Engine
	Elasticsearch
	Google Search
	MadCap Search
	Setting the Search Abstract Character Limit
	Including Glossary Terms in Search Results
	Setting Search Result Importance
	Setting the Number of Search Results Per Page
	Generating Sitemaps for SEO
	Ranking Search Results
	Optimizing Your Content
	Meta Descriptions for Topics
	Optimizing Your Site


	APPENDIX
	PDFs


